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FCC NOTICE
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These

limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment.

This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction

manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful

interference in which case the user will be required to correct the interference at his own expense.

WARNING:
Changes or modification made to this equipment, not expressly approved by Toshiba Tec or parties authorized by Toshiba Tec could

void the user’s authority to operate the equipment.

For European models only:

WARNING:
This product complies with Class A for network connection. In a domestic environment this product may cause radio interference in

which case the user may be required to take adequate measures.

1. Do not touch the connector terminal when disconnecting the cables of peripheral equipment.

2. Before opening any covers or removing any units from the copier, discharge the static electricity from your body by touching a

metal part of the copier.

This product is carrying the CE-Mark in accordance with the related European Directives. Responsible for CE-marking is TOSHIBA

TEC GERMANY IMAGING SYSTEMS GmbH Carl-Schurz-Str. 7, 41460 Neuss, Germany.

e-mail: customerservice@toshibatec-tgis.com

Copyright © TOSHIBA TEC Corp. 2002 All Rights Reserved.
Under the copyright laws, this manual cannot be reproduced in any form without prior written permission of TOSHIBA TEC.  No patent liability

is assumed, with respect to the use of the information contained herein.

No part of this manual may be copied in whole or part without permission.

The contents of this manual may change without notification.

This Class A digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe A est conformé à la norme NMB-003 du Canada.

The software described in this publication is furnished under license and may only be used or copied in accordance with the terms of such license.

This product may be covered by one of more of the following U.S. Patents: 4,500,919, 4,837,722, 5,212,546, 5,343,311, 5,424,754, 5,467,446, 5,506,946,
5,517,334, 5,537,516, 5,543,940, 5,553,200, 5,615,314, 5,619,624, 5,625,712, 5,666,436, 5,760,913, 5,818,645, 5,835,788, 5,867,179, 5,959,867, 5,970,174,
5,982,937, 5,995,724, 6,002,795, 6,025,922, 6,041,200, 6,065,041, 6,112,665, 6,122,407, 6,134,018, 6,141,120, 6,166,821, 6,185,335, 6,201,614, 6,215,562,
6,219,659, 6,222,641, 6,224,048, 6,225,974, 6,226,419, 6,238,105, 6,239,895, 6,256,108, 6,269,190, 6,289,122, 6,292,270, 6,310,697, 6,327,047, 6,327,050,
6,327,052, RE36,947, D406,117, D416,550, D417,864, D419,185, D426,206, D439,851, D444,793

Trademarks

EFI, Fiery, the Fiery logo, Fiery Driven and RIP-While-Print are registered trademarks of Electronics For Imaging, Inc. in the U.S. Patent and Trademark Office and/
or certain other foreign jurisdictions.

The Electronics For Imaging logo, the Fiery Driven logo, Command WorkStation, DocBuilder, DocBuilder Pro, Fiery X3e, Fiery FreeForm, Fiery Scan, Fiery
ScanBuilder, Fiery WebInstaller, Fiery WebScan, Fiery WebSpooler, Fiery WebStatus, Fiery WebTools, NetWise, Velocity, Velocity Balance, Velocity Build, Velocity
Design, Velocity Estimate, and Velocity Scan are trademarks of Electronics For Imaging, Inc.

All other terms and product names may be trademarks or registered trademarks of their respective owners, and are hereby acknowledged.

Legal Notices

APPLE COMPUTER, INC. (“APPLE”) MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, REGARDING THE APPLE SOFTWARE. APPLE DOES NOT WARRANT, GUARANTEE, OR
MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF THE USE OF THE APPLE SOFTWARE IN TERMS OF ITS CORRECTNESS,
ACCURACY, RELIABILITY, CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE APPLE SOFTWARE IS
ASSUMED BY YOU. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO
YOU.

IN NO EVENT WILL APPLE, ITS DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL OR
INDIRECT DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, AND
THE LIKE) ARISING OUT OF THE USE OR INABILITY TO USE THE APPLE SOFTWARE EVEN IF APPLE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES. BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES,
THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU.

Apple’s liability to you for actual damages from any cause whatsoever, and regardless of the form of the action (whether in contract, tort [including negligence],
product liability or otherwise), will be limited to $50.
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SOFTWARE LICENSE AGREEMENT
YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING THIS SOFTWARE. IF YOU DO NOT AGREE TO
THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT USE THE SOFTWARE. INSTALLING OR USING THE SOFTWARE INDICATES
THAT YOU AGREE TO AND ACCEPT THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO ACCEPT THE TERMS OF THIS
AGREEMENT YOU MAY RETURN THE UNUSED SOFTWARE FOR A FULL REFUND TO THE PLACE OF PURCHASE.

LICENSE
Electronics For Imaging, Inc. grants you a non-exclusive, non-transferable license to use the software and accompanying documentation (“Software”) included with the
controller GA-1140 for TOSHIBA e-STUDIO550/650/810 Series printer you have purchased, including without limitation PostScript® software provided by Adobe
Systems Incorporated.

You may:
a. use the Software solely for your own customary business purposes and solely with the controller GA-1140 for TOSHIBA e-STUDIO550/650/810 Series;
b. use the digitally-encoded machine-readable outline and bitmap programs (“Font Programs”) provided with the controller GA-1140 for TOSHIBA e-

STUDIO550/650/810 Series in a special encrypted format (“Coded Font Programs”) to reproduce and display designs, styles, weights, and versions of letters,
numerals, characters and symbols (“Typefaces”) solely for your own customary business purposes on a monitor used with the controller GA-1140 for TOSHIBA e-
STUDIO550/650/810 Series;

c. use the trademarks used by Electronics For Imaging to identify the Coded Font Programs and Typefaces reproduced therefrom (“Trademarks”); and
d. assign your rights under this Agreement to a transferee of all of your right, title and interest in and to the controller GA-1140 for TOSHIBA e-STUDIO550/650/

810 Series provided the transferee agrees to be bound by all of the terms and conditions of this Agreement.

You may not:
a. make use of the Software, directly or indirectly, to print bitmap images with print resolutions of greater than 600 dots per inch, or to generate fonts or typefaces

for use other than with the controller GA-1140 for TOSHIBA e-STUDIO550/650/810 Series;
b. make or have made, or permit to be made, any copies of the Software, Coded Font Programs, accompanying documentation or portions thereof, except as

necessary for use with the controller GA-1140 for TOSHIBA e-STUDIO550/650/810 Series purchased by you; provided, however, that under no circumstances
may you make or have made, or permit to be made, any copies of that certain portion of the Software which has been included on the controller GA-1140 for
TOSHIBA e-STUDIO550/650/810 Series hard disk drive or ROM. You may not copy the documentation;

c. attempt to alter, disassemble, decrypt or reverse engineer the Software, Coded Font Programs.
d. rent or lease the Software.

PROPRIETARY RIGHTS
You acknowledge that the Software, Coded Font Programs, Typefaces, and Trademarks are proprietary to Electronics For Imaging and its suppliers and that title and
other intellectual property rights therein remain with Electronics For Imaging and its suppliers. Except as stated above, this Agreement does not grant you any right to
patents, copyrights, trade secrets, trademarks (whether registered or unregistered), or any other rights, franchises or licenses in respect of the Software, Coded Font
Programs, Typefaces, or Trademarks. You may not adapt or use any trademark or trade name which is likely to be similar to or confusing with that of Electronics For
Imaging or any of its suppliers or take any other action which impairs or reduces the trademark rights of Electronics For Imaging or its suppliers. The trademarks may
only be used to identify printed output produced by the Coded Font Programs. At the reasonable request of Electronics For Imaging, you must supply samples of any
Typeface identified with a trademark.

CONFIDENTIALITY
You agree to hold the Software and Coded Font Programs in confidence, disclosing the Software and Coded Font Programs only to authorized users having a need to
use the Software and Coded Font Programs as permitted by this Agreement and to take all reasonable precautions to prevent disclosure to other parties.

REMEDIES
Unauthorized use, copying or disclosure of the Software, Coded Font Programs, Typefaces, or Trademarks will result in automatic termination of this license and will
make available to Electronics For Imaging other legal remedies.

LIMITED WARRANTY AND DISCLAIMER
Electronics For Imaging warrants that, for a period of ninety (90) days from the date of delivery to you, the Software under normal use will perform without significant
errors that make it unusable. Electronics For Imaging’s entire liability and your exclusive remedy under this warranty (which is subject to you returning the controller
GA-1140 for TOSHIBA e-STUDIO550/650/810 Series to Electronics For Imaging or an authorized dealer) will be, at Electronics For Imaging’s option, to use
reasonable commercial efforts to attempt to correct or work around errors, to replace the Software with functionally equivalent software, or to refund the purchase price
and terminate this Agreement. Some states/jurisdictions do not allow limitations on duration of implied warranty, so the above limitation may not apply to you.

For warranty service, please contact your authorized service/support center.

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY, ELECTRONICS FOR IMAGING MAKES AND YOU RECEIVE NO WARRANTIES OR
CONDITIONS ON THE SOFTWARE OR CODED FONT PROGRAMS, EXPRESS, IMPLIED, STATUTORY, OR IN ANY OTHER PROVISION OF THIS
AGREEMENT OR COMMUNICATION WITH YOU, AND ELECTRONICS FOR IMAGING SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTY
OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Electronics For Imaging does not warrant that the operation of the
software will be uninterrupted or error free or that the Software will meet your specific requirements.
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LIMITATION OF LIABILITY
IN NO EVENT WILL ELECTRONICS FOR IMAGING OR ITS SUPPLIERS BE LIABLE FOR ANY DAMAGES, INCLUDING LOSS OF DATA, LOST
PROFITS, COST OF COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES ARISING FROM THE USE OF THE
SOFTWARE, OR CODED FONT PROGRAMS, HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY. THIS LIMITATION WILL APPLY EVEN
IF ELECTRONICS FOR IMAGING OR ANY AUTHORIZED DEALER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. YOU
ACKNOWLEDGE THAT THE PRICE OF THE CONTROLLER GA-1140 FOR TOSHIBA e-STUDIO550/650/810 Series  REFLECTS THIS ALLOCATION
OF RISK. BECAUSE SOME STATES/JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL
OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

EXPORT CONTROLS
You agree that you will not export or re-export the Software or Coded Font Programs in any form without the appropriate United States and foreign government
licenses. Your failure to comply with this provision is a material breach of this Agreement.

GOVERNMENT USE
Use, duplication or disclosure of the Software by the United States Government is subject to restrictions as set forth in subdivision (c) (1) (ii) of the Rights in Technical
Data and Computer Software clause at DFARS 252.227-7013 or in subparagraphs (c) (1) and (2) of the Commercial Computer Software-Restricted Right Clause at 48
CFR 52.227-19, as applicable.

THIRD PARTY BENEFICIARY
You are hereby notified that Adobe Systems Incorporated, a California corporation located at 345 Park Avenue, San Jose, CA 95110-2704 (“Adobe”) is a third-party
beneficiary to this Agreement to the extent that this Agreement contains provisions which relate to your use of the Fonts, the Coded Font Programs, the Typefaces and
the Trademarks licensed hereby. Such provisions are made expressly for the benefit of Adobe and are enforceable by Adobe in addition to Electronics for Imaging.

GENERAL
This Agreement will be governed by the laws of the State of California.
This Agreement is the entire agreement held between us and supersedes any other communications or advertising with respect to the Software and Coded Font
Programs.
If any provision of this Agreement is held invalid, the remainder of this Agreement shall continue in full force and effect.

If you have any questions concerning this Agreement, please see Electronics For Imaging’s web site at www.efi.com.

Electronics For Imaging
303 Velocity Way
Foster City, CA 94404
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Thank you for purchasing Toshiba Tec’s GA-1140 Network Printer Controller.  This USER’S GUIDE

explains the instructions for users to set up your computer and print to GA-1140 printer.  Read this

guide before printing to your e-STUDIO550/650/810 with the GA-1140 Network Printer Board.  Keep

this guide within easy reach, and use it to configure quality printing environment and make the best of

your printer’s functions.

Preface
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About the Documentation
About this Guide

This manual describes how to install the user software for the TOSHIBA GA-1140 Network Printer

BoardTM, set up printing, and manage print jobs from Microsoft Windows and Apple Mac OS computers.

For information about setting up network servers and clients to use the GA-1140, see Administrator’s

Guide.  For general information on using the copier, your computer, your application software, or your

network, see the manuals that accompany those products.

The term “GA-1140” is used in this manual to refer to the TOSHIBA GA-1140 Network Printer Board.

Convention
 indicates features that require the PS3 Upgrade option.

 indicates features and functionality for which PS3 Scan & HDD Upgrade option is required.

About Other Manuals

There are also following manuals which are included in the User Documentation CD-ROM:

Administrator’s Guide - explains basic configuration and administration of the GA-1140 for the

supported platforms and network environments.  It is also includes guidelines for setting up Windows

NT/2000 and Novell NetWare servers to provide printing services to clients.

 : Fiery Utilities Guide and Scan & E-mail Guide are also included in the PS3 Scan & HDD

Upgrade (GE-1060+GE-1110).

Fiery Utilities Guide - explains how to use optional software for the GA-1140 which are

available with the PS3 Scan & HDD Upgrade kit such as the Fiery WebTools, Command

WorkStation, and the DocBuilder Pro.

Scan & E-mail Guide - explains basic configuration and operation of the GA-1140 scan and e-

mail service function which are available with the PS3 Scan & HDD Upgrade kit.
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Introduction

About User Software CD-ROM
Contents of User Software CD-ROM

The contents of User Software CD-ROM are:

Windows

[language]\Prntdrvr\Pcl6_drvr\[Windows version] - includes Oemsetup.inf

and other files to install the PCL6 printer driver by Add Printer Wizard.

[language]\Prntdrvr\Ps_drvr\[Windows version] - includes Oemsetup.inf

and other files to install the PostScript printer driver by Add Printer Wizard, and

Printer Description file.

Afm - includes Setup.exe to install the Agfa Monotype Font Manager 2000.

Installr - includes Setup.exe to install the PCL6 printer driver and PostScript

printer driver.

SUPPLEMENT:

For further information about user softwares for Windows, please refer to “About User Software

for Windows”. P14 “About User Software for Windows”
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Mac OS

The contents of User Software CD-ROM are:

[language]:Printer Driver - includes an installer for AdobePS 8.7.2 printer

driver and other files such as PPD files under the Printer Description folder.

SUPPLEMENT:

For further information about user softwares for Mac OS, please refer to “About User Software

for Mac OS”. P72 “About User Software for Mac OS”

Fonts - is an installer for screen and printer fonts.
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About User Software for Windows
The following user softwares are included in the User Software CD-ROM:

PCL6 Printer Driver - enables you to print to the GA-1140 from Windows computers; supports all

special GA-1140 PCL6 print features.  This printer driver is utilized for printing the document which

uses the TrueType font.

 PostScript Printer Driver - enables to print to the GA-1140 from Windows computers; supports

special Fiery and PostScript 3 features.  This printer driver is utilized for printing the high-graphical

document which uses the PostScript font and graphics. The PS3 Upgrade option or PS3 Scan & HDD

Upgrade option should be installed on the GA-1140 in order to use the PostScript printer driver.

 PostScript Printer Description file (PPD) - allows the GA-1140 to appear in popular applications’

Print and Page Setup dialog boxes for use with the PostScript printer driver.  Some applications require

the PPD file to be copied into specific location to enable printing with the PostScript printer driver.  In

this case, copy the PPD file to appropriate location to enable printing from an application.

Agfa Monotype Font Manger 2000 - enables to manage your fonts on Windows, including installing,

uninstalling, organizing, and previewing TrueType and Type 1 fonts.  When you are using the PCL6

printer driver for printing, please install this software because this supports installing fonts that are

compatible to internal PCL fonts on the GA-1140.
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Planning for Installation

When using PCL6 Printer Driver

When you want to print using the PCL6 printer driver, install the following softwares:

1. Install the PCL6 printer driver.

P16 “Installing the Printer Driver”

2. Install the Agfa Font Manager 2000.

P69 “Installing the Agfa Monotype Font Manager 2000”

When using PostScript Printer Driver

 : The PS3 Upgrade (GE-1020) or PS3 Scan & HDD Upgrade (GE-1060+GE-1110) is required to

use the PostScript Driver.

When you want to print using the PostScript printer driver, install the following softwares:

1. Install the PostScript printer driver.

P16 “Installing the Printer Driver”

The installation of user softwares on Windows is different depending on what you expect for printing.

The PCL6 printer driver is effective for printing a document which uses TrueType fonts, such as a

Microsoft Word document so on.

The PostScript printer driver is effective for high-graphical document which uses PostScript fonts and

graphics, such as Adobe PageMaker so on.
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Installing the Printer Driver
About the Installation

Before installing the printer driver to your computer, read this section to understand about installation.

Type of Printer Driver

Two types of printer driver are available for the GA-1140:

• PCL6 Printer Driver

The PCL6 printer driver allows you to print to the GA-1140 as a PCL printer.

• PostScript Printer Driver

The PostScript printer driver allows you to print to the GA-1140 as a PostScript Level 3 compatible

printer.

 : The PS3 Upgrade (GE-1020) or PS3 Scan & HDD Upgrade (GE-1060+GE-1110) is required to

use the PostScript Printer Driver.

System Requirements

To install the printer drivers on a Windows workstation, the following environments are required.

Hardware: PC/AT compatible with an 80486, AMD, or Pentium processor

OS: Windows 95, Windows 98, Windows Me

Windows NT 4.0 with Service Pack 6 or later

Windows 2000 with Service Pack 2 or later

Windows XP

Memory: 16MB or more for Windows 95

24MB or more for Windows 98

32MB or more for Windows Me

32MB or more for Windows NT 4.0

64MB or more for Windows 2000

64MB or more for Windows XP
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About the Installation Procedure

Please find the installation procedure suited to your environment from the followings:

Step1: Installing the Printer Driver
Installing the printer driver varies depending on how you configure the connection for printing:

For Parallel Printing

P18 “Installing the Printer Driver for Parallel Printing”

For SMB Printing

P21 “Installing the Printer Driver for SMB Printing”

For LPR Printing

P31 “Installing the Printer Driver for LPR Printing”

For IPP Printing

P44 “Installing the Printer Driver for IPP Printing”

For Novell Printing

P49 “Installing the Printer Driver for Novell Printing”

Step2: Configuring the Options
P59 “Configuring the Options”

Step3: Setting the User Information
P66 “Setting the User Information”

SUPPLEMENT:

When you want to print from some Windows applications supported the PS printing such as

Adobe PageMaker, you should copy the printer description file to a specific folder.

P68 “Copying the Printer Description Files for Windows”
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Installing the Printer Driver for Parallel Printing

PREPARATION:

Before installing the printer driver for parallel printing, please make sure of the following:

• The GA-1140 printer is connected to your computer and turned on.

To make sure above statement, see Administrator’s Guide to perform the set up for parallel

printing.

1 Insert the User Software CD-ROM into the CD-
ROM drive.
• The installer automatically starts and the Welcome

dialog box appears.

2 Click on [Next].
• The Software License Agreement dialog box

appears.

3 Click on [Yes].
• The Setup Type dialog box appears.

REQUIREMENT:

You must log into as a user who has the “Administrators” or “Power Users” privilege when using

Windows NT 4.0, Windows 2000, and Windows XP.

SUPPLEMENT:

When the installer does not automatically

start, double-click on “Setup.exe” in the

“Installr” folder of the User Software CD-

ROM.
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4 Select “Custom” and click on [Next].
• The Choose Destination dialog box appears.

5 Click on [Next].
• Click on [Browse...] and select the folder only If you

want to change the folder which the software will be

installed.

6 Select the components to be installed and
click on [Next].
• The Select Port dialog box appears.

PCL6 Driver
Check this to install the PCL6 printer driver.

PS Driver
Check this to install the PostScript printer driver.

AFM
Check this to install the Agfa Monotype Font Manager 2000.
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7 Select “LPT1” and click on [Next].
• The Start Copying Files dialog box appears.

8 Click on [Next].
• Start copying files.

 : The PS3 Upgrade (GE-1020) or PS3 Scan & HDD Upgrade (GE-1060+GE-1110) is required to

use the PostScript Driver.

9 Change the name if desired and click on
[Next].
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Installing the Printer Driver for SMB Printing

PREPARATIONS:

Before installing the printer driver for SMB printing, please make sure of the following:

• The GA-1140 printer is connected to the network and turned on.

• The TCP/IP setting is completed correctly.

• The Windows Printing is completed correctly.

To make sure above statements, ask your network administrator or see Administrator’s Guide to

perform the set up for SMB printing.

SUPPLEMENT:

When you want to install the Agfa Monotype Font Manager 2000, you should install it separately.

P69 “Installing the Agfa Monotype Font Manager 2000”

The procedure to Install the printer driver for SMB printing is different depending on the version of the

Windows.

P22 “Windows 95/98/Me”

P26 “Windows NT 4.0/2000/XP”

10 Click on [Finish].
• The installation is completed.

• When you selected to install the Agfa Monotype Font

Manager 2000, the Welcome dialog box appears.  In

this case, continue the installation.

P69 “Installing the Agfa Monotype Font Manager

2000”

11 Continue the operation to configure the option
settings on the printer driver.

P59 “Configuring the Options”
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Windows 95/98/Me

The procedure here describes an installation on Windows 98.  The procedures are the same when

other versions of Windows is used.

 : When the PS3 Scan & HDD Upgrade (GE-1060+GE-1110) is installed on your GA-1140

printer, a printer driver, which is selected for the SMB Printing option in the TopAccess, is

automatically installed by following the procedure here.  If you want to install another printer

driver for SMB printing, right-click the queue and select [Install] to install another printer driver.

When you install both printer drivers by this method, change the emulation of the printer driver

for printing by right-clicking the printer icon in the Printers folder and select [Properties], then

select the desired printer driver in the “Print using the following driver” menu in the Details tab.

1 Open the GA-1140 printer in the Network
Neighborhood with the Windows Explorer, and
double-click on a queue.
• Select a queue depending on how you want to print.

Direct - print jobs are sent straight to the printer

without spooling.

Hold - print jobs are held until users operate copying

or moving them to the Print queue with the job

management tools.

Print - print jobs are spooled to the hard disk in the

GA-1140 printer and printed out.  Use this queue for

general printing.

• The Printers dialog box appears.

2 Click on [Yes].
• When installing to Windows 95, Windows 98, or

Windows Me, the Add Printer Wizard dialog box

appears.  Continue to next step.

 : The Hold queue and Print queue are only available when the PS3 Scan & HDD Upgrade (GE-

1060+GE-1110) is installed.
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3 Select whether printing MS-DOS-based
programs and click on [Next].
• When the PS3 Scan & HDD Upgrade (GE-1060+GE-

1110) is installed on your GA-1140 printer, go to step

10.

4 Click on [Have Disk...].
• The Install From Disk dialog box appears.

7 Locate the directory where the printer driver
for Windows 95/98/Me is located, select the
“oemsetup.inf” file, and click on [OK].
• When you want to install the PCL6 printer driver,

locate “[CD-ROM drive]:\English\Prntdrvr\Pcl6_drvr

\Win_9x_ME”.

• When you want to install the PostScript printer driver,

locate “[CD-ROM drive]:\English\Prntdrvr\Ps_drvr

\Win_9x_ME”.

5 Click on [Browse...].
• The Locate File dialog box appears.

6 Insert the User Software CD-ROM into the CD-
ROM drive.
• When inserting the User Software CD-ROM, the

installer may automatically start.  Click on [Cancel] to

exit the installer and continue the operation.
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8 Click on [OK].

9 Select the printer driver that compatible to
your GA-1140 printer and click on [Next].
• When the GA-1140 printer is an US version, which

the default paper size type is LT system, select

“TOSHIBA e-STUDIO810 srs-PCL6UC” (when you

install the PCL6 printer driver) or “TOSHIBA e-

STUDIO810 srs-PS3UC” (when you install the

PostScript printer driver).

• When the GA-1140 printer is an European version,

which the default paper size type is A4 system, select

“TOSHIBA e-STUDIO810 srs-PCL6EU” (when you

install the PCL6 printer driver) or “TOSHIBA e-

STUDIO810 srs-PS3EU” (when you install the

PostScript printer driver).

10 Change the name if desired, select whether
using this printer as a default printer, and click
on [Next].

 : The PS3 Upgrade (GE-1020) or PS3 Scan & HDD Upgrade (GE-1060+GE-1110) is required to

use the PostScript Driver.
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13 The printer driver is installed and the print
queue window appears.

11 Select “Yes” to print a test page and click on
[Finish].

12 Make sure a test page is printed successfully
and click on [Yes] to close the dialog box.

14 Continue the operation to configure the option
settings on the printer driver.

P59 “Configuring the Options”
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Windows NT 4.0/2000/XP

REQUIREMENT:

You must log in Windows as a user who has the “Administrators” or “Power Users” privilege.

To install the printer driver for SMB printing, install the printer driver using the installer in the User

Software CD-ROM.

The procedure here describes an installation on Windows 2000.  The procedures are same when

Windows NT 4.0 or Windows XP is used although the some dialog boxes are different.

1 Insert the User Software CD-ROM into the CD-
ROM drive.
• The installer automatically starts and the Welcome

dialog box appears.

SUPPLEMENT:

When the installer does not automatically

start, double-click on “Setup.exe” in the

“Installr” folder of the User Software CD-

ROM.

 : When you are installing to the Windows NT 4.0:

When the PS3 Scan & HDD Upgrade (GE-1060+GE-1110) is installed on your GA-1140

printer, you can also install a printer driver for Windows NT 4.0, which is selected for the SMB

Printing option in the TopAccess, by double-clicking on the desired queue displayed in the

Network Neighborhood with the Windows Explorer.  If you want to install another printer driver

for SMB printing, right-click the queue and select [Install] to install another printer driver.  When

you install both printer drivers by this method, change the emulation of the printer driver for

printing by right-clicking the printer icon in the Printers folder and select [Properties], then

select the desired printer driver in the “Drivers” menu in the Details tab.
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2 Click on [Next].
• The Software License Agreement dialog box

appears.

3 Click on [Yes].
• The Setup Type dialog box appears.

4 Select “Custom” and click on [Next].
• The Choose Destination dialog box appears.

5 Click on [Next].
• Click on [Browse...] and select the folder only If you

want to change the folder which the software will be

installed.
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 : The PS3 Upgrade (GE-1020) or PS3 Scan & HDD Upgrade (GE-1060+GE-1110) is required to

use the PostScript Driver.

7 Click on [Add Port...].
• The Printer Ports dialog box appears.

8 Select “Local Port” and click on [New Port...].
• The Port Name dialog box appears.

6 Select the components to be installed and
click on [Next].
• The Select Port dialog box appears.

PCL6 Driver
Check this to install the PCL6 printer driver.

PS Driver
Check this to install the PostScript printer driver.

AFM
Check this to install the Agfa Monotype Font Manager 2000.
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11 Select the port that you create and click on
[Next].
• The Start Copying Files dialog box appears.

9 Enter “\\[Server Name]\[Queue Name]” in the
“Enter a port name” field, and click on [OK].
• The [Server Name] of the port name must be the

server name that you entered for the Server Name of

the Windows Printing Service setting on TopAccess.

The default server name of the GA-1140 printer is “e-

STUDIO810”.

• The [Queue Name] of the port name must be a queue

name, direct, hold, or print, on the GA-1140 printer.

Enter a queue depending on how you operate the

printing.

direct - print jobs are sent straight to the printer

without spooling.

hold - print jobs are held until users operate copying

or moving them to the Print queue with the job

management tools.

print - print jobs are spooled to the hard disk in the

GA-1140 printer and print out.  Use this queue for a

general printing.

10 Click on [Close] to close the dialog box.
• The screen returns to the Select Port dialog box.

 : The Hold queue and Print queue are only available when the PS3 Scan & HDD Upgrade (GE-

1060+GE-1110) is installed.
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14 Click on [Finish].
• The installation is completed.

• When you selected to install the Agfa Monotype Font

Manager 2000, the Welcome dialog box appears.  In

this case, continue the installation.

P69 “Installing the Agfa Monotype Font Manager

2000”

15 Continue the operation to configure the option
settings on the printer driver.

P59 “Configuring the Options”

12 Click on [Next].
• Start copying files.

13 Change the name if desired and click on
[Next].
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Installing the Printer Driver for LPR Printing

PREPARATIONS:

Before installing the printer driver for LPR printing, please make sure of the following:

• The GA-1140 printer is connected to the network and turned on.

• The TCP/IP setting is completed correctly.

• The LPD Printing is completed correctly.

To make sure above statements, ask your network administrator or see Administrator’s Guide to

perform the set up for LPR printing.

The LPR printing is available only for Windows NT 4.0, Windows 2000, and Windows XP.  The

procedure to Install the printer driver for LPR printing is different depending on the version of the

Windows.

P32 “Windows NT 4.0”

P37 “Windows 2000 and Windows XP”
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Windows NT 4.0

REQUIREMENTS:

• The TCP/IP Printing Service is installed and running on your Windows NT 4.0.

• The TCP/IP protocol is installed and configured correctly on your Windows NT 4.0.

• You must log in Windows as a user who has the “Administrators” or “Power Users” privilege.

To install the printer driver for LPR printing, install the printer driver using the installer in the User

Software CD-ROM.

1 Insert the User Software CD-ROM into the CD-
ROM drive.
• The installer automatically starts and the Welcome

dialog box appears.

2 Click on [Next].
• The Software License Agreement dialog box

appears.

3 Click on [Yes].
• The Setup Type dialog box appears.

SUPPLEMENT:

When the installer does not automatically

start, double-click on “Setup.exe” in the

“Installr” folder of the User Software CD-

ROM.
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4 Select “Custom” and click on [Next].
• The Choose Destination dialog box appears.

5 Click on [Next].
• Click on [Browse...] and select the folder only If you

want to change the folder which the software will be

installed.

6 Select the components to be installed and
click on [Next].
• The Select Port dialog box appears.

PCL6 Driver
Check this to install the PCL6 printer driver.

PS Driver
Check this to install the PostScript printer driver.

AFM
Check this to install the Agfa Monotype Font Manager 2000.



34

 : The PS3 Upgrade (GE-1020) or PS3 Scan & HDD Upgrade (GE-1060+GE-1110) is required to

use the PostScript Driver.

7 Click on [Add Port...].
• The Printer Ports dialog box appears.

9 Enter the IP address of the GA-1140 printer in
the “Name or address of server providing lpd”
field and a queue name in the “Name of printer
or print queue on that server” field, and click
on [OK].
• When your network uses DNS or WINS server, enter

the printer name of the GA-1140 provided from DNS

or WINS in the “Name or address of server providing

lpd” field.

• In the “Name of printer or print queue on that server”

field, you have to enter a queue name, direct, hold, or

print, on the GA-1140 printer.  Enter a queue

depending on how you want to print.

direct - print jobs are sent straight to the printer

without spooling.

hold - print jobs are held until users operate copying

or moving them to the Print queue with the job

management tools.

print - print jobs are spooled to the hard disk in the

GA-1140 printer and printed out.  Use this queue for

general printing.

8 Select “LPR Port” and click on [New Port...].
• When “LPR Port” is not listed, make sure the TCP/IP

Printing Service is installed on your Windows NT 4.0.

“LPR Port” is not listed unless the TCP/IP Printing

Service is installed.

• The Add LPR compatible printer dialog box appears.
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10 Click on [Close] to close the dialog box.
• The screen returns to the Select Port dialog box.

 : The Hold queue and Print queue are only available when the PS3 Scan & HDD Upgrade (GE-

1060+GE-1110) is installed.

11 Select the port that you create and click on
[Next].
• The Start Copying Files dialog box appears.

12 Click on [Next].
• Start copying files.
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14 Click on [Finish].
• The installation is completed.

• When you selected to install the Agfa Monotype Font

Manager 2000, the Welcome dialog box appears.  In

this case, continue the installation.

P69 “Installing the Agfa Monotype Font Manager

2000”

15 Continue the operation to configure the option
settings on the printer driver.

P59 “Configuring the Options”

13 Change the name if desired and click on
[Next].
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Windows 2000 and Windows XP

REQUIREMENTS:

• The TCP/IP protocol is installed and configured correctly on your Windows 2000/XP.

• You must log in Windows as a user who has the “Administrators” or “Power Users” privilege.

To install the printer driver to use LPR printing, configure the LPR port first, and then install the printer

driver using the installer in the User Software CD-ROM.

The procedure here describes an installation on Windows 2000.  The procedures are the same when

Windows XP is used.

1 Insert the User Software CD-ROM into the CD-
ROM drive.
• The installer automatically starts and the Welcome

dialog box appears.

2 Click on [Next].
• The Software License Agreement dialog box

appears.

3 Click on [Yes].
• The Setup Type dialog box appears.

SUPPLEMENT:

When the installer does not automatically

start, double-click on “Setup.exe” in the

“Installr” folder of the User Software CD-

ROM.
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4 Select “Custom” and click on [Next].
• The Choose Destination dialog box appears.

5 Click on [Next].
• Click on [Browse...] and select the folder only If you

want to change the folder which the software will be

installed.

6 Select the components to be installed and
click on [Next].
• The Select Port dialog box appears.

PCL6 Driver
Check this to install the PCL6 printer driver.

PS Driver
Check this to install the PostScript printer driver.

AFM
Check this to install the Agfa Monotype Font Manager 2000.
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8 Select “Standard TCP/IP Port” and click on
[New Port...].
• The Add Standard TCP/IP Printer Port Wizard dialog

box appears.

9 Click on [Next].

 : The PS3 Upgrade (GE-1020) or PS3 Scan & HDD Upgrade (GE-1060+GE-1110) is required to

use the PostScript Driver.

7 Click on [Add Port...].
• The Printer Ports dialog box appears.
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10 Enter the IP address of the GA-1140 printer in
the “Printer Name or IP Address” field and
click on [Next].
• When your network uses DNS or WINS server, enter

the printer name of the GA-1140 provided from DNS

or WINS in the “Printer Name or IP Address” field.

• In the “Port Name” field, the port name is

automatically entered according to the IP address or

DNS name entered in the “Printer Name or IP

Address” field.

11 Select “Custom” and click on [Settings...].
• The Configure Standard TCP/IP Port Monitor dialog

box appears.

12 Select “LPR” at the “Protocol” option, enter a
queue name in the “Queue Name” field at the
“LPR Settings” option, and then click on [OK].
• In the “Queue Name” field, you have to enter a queue

name, direct, hold, or print, on the GA-1140 printer.

Enter a queue depending on how you want to print.

direct - print jobs are sent straight to the printer

without spooling.

hold - print jobs are held until users operate copying

or moving them to the Print queue with the job

management tools.

print - print jobs are spooled to the hard disk in the

GA-1140 printer and printed out.  Use this queue for

general printing.

• The screen returns to the Add Standard TCP/IP

Printer Port Wizard dialog box.
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13 Click on [Next].

 : The Hold queue and Print queue are only available when the PS3 Scan & HDD Upgrade (GE-

1060+GE-1110) is installed.

SUPPLEMENT:

If you have enabled the Port 9100 printing at the GA-

1140 LPD Printing Service options, you can setting up

Port 9100 printing as well.  When you want to set up

Port 9100 printing, select “Raw” at the “Protocol”

option, and enter the port number in the “Port Number”

field at the Raw Settings” option.  The port number is

different for each print connection as following:

9101 - use direct queue for printing.

9100 (default) or 9102 - use print queue for printing.

9103 - use hold queue for printing.
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17 Click on [Next].
• Start copying files.

16 Select the LPR Port that you create and click
on [Next].
• The Start Copying Files dialog box appears.

14 Click on [Finish].
• The screen returns to the Printer Ports dialog box.

15 Click on [Close].
• The screen returns to the Select Port dialog box.
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19 Click on [Finish].
• The installation is completed.

• When you selected to install the Agfa Monotype Font

Manager 2000, the Welcome dialog box appears.  In

this case, continue the installation.

P69 “Installing the Agfa Monotype Font Manager

2000”

20 Continue the operation to configure the option
settings on the printer driver.

P59 “Configuring the Options”

18 Change the name if desired and click on
[Next].
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Installing the Printer Driver for IPP Printing

PREPARATIONS:

Before installing the printer driver for IPP printing, please make sure of the following:

• The GA-1140 printer is connected to the network and turned on.

• The TCP/IP setting is completed correctly.

To make sure above statements, ask your network administrator or see Administrator’s Guide to

perform the set up for IPP printing.

1 Click on [Start] and select [Printers] in
[Settings] (Windows 2000) or select [Printers
and Faxes] (Windows XP).
• The Printers folder is opened.

SUPPLEMENT:

When you want to install the Agfa Monotype Font Manager 2000, you should install it separately.

P69 “Installing the Agfa Monotype Font Manager 2000”

REQUIREMENTS:

• The TCP/IP protocol is installed and configured correctly on your Windows 2000.

• You must log in Windows as a user who has the “Administrators” or “Power Users” privilege.

IPP printing is available only for Windows 2000 and Windows XP.  To install the printer driver to use

IPP printing, install the printer driver by Add Printer Wizard.

The procedure here describes an installation on Windows 2000.  The procedures are the same when

Windows XP is used.
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3 Click on [Next].

4 Select “Network printer” and click on [Next].

2 Double-click on the [Add Printer] icon
(Windows 2000) or click on the “Add a Printer”
hyperlink in the “Printer Tasks” (Windows XP).
• The Add Printer Wizard dialog box appears.
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6 Click on [OK].

5 Select “Connect to a printer on the Internet or
on your intranet”, enter “http://[IP address]/
ipp/direct” in the “URL” field, and then click on
[Next].
• Enter the IP address of GA-1140 printer instead of [IP

address].

Example: IP address = 192.168.0.20

http://192.168.255.48/ipp/direct

• When your network uses DNS or WINS server, enter

the printer name of the GA-1140 provided from DNS

or WINS instead of [IP address].

Example: Print Server Name = Server-907043

http://Server-907043/ipp/direct

• The Connect to Printer dialog box appears.

7 Click on [Have Disk...].
• The Install From Disk dialog box appears.

9 Click on [Browse...].
• The Locate File dialog box appears.

 : Please enter “ipp/print” instead of the “ipp/direct” for the URL when the PS3 Scan & HDD

Upgrade (GE-1060+GE-1110) is installed.

8 Insert the User Software CD-ROM into the CD-
ROM drive.
• When inserting the User Software CD-ROM, the

installer may automatically start.  Click on [Cancel] to

exit the installer and continue the operation.



47

Installing U
ser

Softw
are on a

W
indow

s C
om

puter

12 Select the printer driver that compatible to
your GA-1140 printer and click on [OK].
• When the GA-1140 printer is a US version, which the

default paper size type is LT system, select

“TOSHIBA e-STUDIO810srs-PCL6UC” (when you

install the PCL6 printer driver) or “TOSHIBA e-

STUDIO810srs-PS3UC” (when you install the

PostScript printer driver).

• When the GA-1140 printer is a European version,

which the default paper size type is A4 system, select

“TOSHIBA e-STUDIO810srs-PCL6EU” (when you

install the PCL6 printer driver) or “TOSHIBA e-

STUDIO810srs-PS3EU” (when you install the

PostScript printer driver).

10 Locate the directory where the printer driver
for your operating system is located, select the
“oemsetup.inf” file, and click on [Open].
• When you want to install the PCL6 printer driver for

Windows 2000:

[CD-ROM drive]:\English\Prntdrvr\Pcl6_drvr\Win_2000

• When you want to install the PostScript printer driver

for Windows 2000:

[CD-ROM drive]:\English\Prntdrvr\PS_drvr\Win_2000

• When you want to install the PCL6 printer driver for

Windows XP:

[CD-ROM drive]:\English\Prntdrvr\Pcl6_drvr\Win_XP

• When you want to install the PostScript printer driver

for Windows XP:

[CD-ROM drive]:\English\Prntdrvr\PS_drvr\Win_XP

11 Click on [OK].
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13 Click on [Finish].
• The printer driver is installed on Windows 2000.

14 Continue the operation to configure the option
settings on the printer driver.

P59 “Configuring the Options”

 : The PS3 Upgrade (GE-1020) or PS3 Scan & HDD Upgrade (GE-1060+GE-1110) is required to

use the PostScript Driver.
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Installing the Printer Driver for Novell Printing

PREPARATIONS:

Before installing the printer driver for Novell printing, please make sure of the following:

• The GA-1140 printer is connected to the network and turned on.

• The TCP/IP setting is completed correctly.  (Required only when you want to use TopAccess

or using the printer with NetWare server 5.x in the TCP/IP network.)

• The IPX/SPX and NetWare settings are completed correctly.

To make sure above statements, ask your network administrator or see Administrator’s Guide to

perform the set up for Novell printing.

SUPPLEMENT:

When you want to install the Agfa Monotype Font Manager 2000, you should install it separately.

P69 “Installing the Agfa Monotype Font Manager 2000”

The procedure to Install the printer driver for Novell printing is different depending on the version of the

Windows.

P50 “Windows 95/98/Me”

P55 “Windows NT 4.0/2000/XP”



50

Windows 95/98/Me

REQUIREMENTS:

• The NetWare server is configured correctly and running on your network.

• The TCP/IP protocol is installed and configured correctly on your Windows computer.

(Required only when using the NetWare server 5.x in the TCP/IP network.)

• The Client for NetWare Networks and the IPX/SPX-compatible protocol are installed on your

Windows computer.  (Required only when using the NetWare server in the IPX/SPX network.)

• The Service for NetWare Directory Services is installed.  (Required only when using the

NetWare server in NDS or NDPS mode.

• You have an appropriate privilege to access to the NetWare server.

1 Open the NetWare server (when using in
bindery mode) or NDS directory tree (when
using in NDS or NDPS mode) in the Network
Neighborhood with the Windows Explorer, and
double-click on a queue.
• Select a queue depending on how you want to print.

[given name]_direct - print jobs are sent straight to

the printer without spooling.

[given name]_hold - print jobs are held until users

operate copying or moving them to the Print queue

with the job management tools.

[given name]_print - print jobs are spooled to the

hard disk in the GA-1140 printer and printed out.  Use

this queue for general printing.

• When using the NetWare 5.x in NDPS mode and the

printer drivers for each Operating System are

installed to a NDPS broker, the printer driver is

automatically installed.

• Unless using the NetWare 5.x in NDPS mode and

printer drivers for each Operating System are

installed to a NDPS broker, the Add Printer Wizard

dialog box appears.  Continue to the next step.

The procedure here describes an installation on Windows 98.  The procedures are same when

Windows 95 or Windows Me is used.



51

Installing U
ser

Softw
are on a

W
indow

s C
om

puter

3 Select whether printing MS-DOS-based
programs and click on [Next].

4 Click on [Have Disk...].
• The Install From Disk dialog box appears.

2 Click on [Yes].
• The Add Printer Wizard dialog box appears.

SUPPLEMENT:

The queue names created on the NetWare server should be either “[given name]_direct”, “[given

name]_hold”, “[given name]_print” ([given name] can be any name).  Those queues correspond

to the GA-1140 printer’s queues, Direct, Hold, and Print.

 : The Hold queue and Print queue are only available when the PS3 Scan & HDD Upgrade (GE-

1060+GE-1110) is installed.

5 Insert the User Software CD-ROM into the CD-
ROM drive.
• When inserting the User Software CD-ROM, the

installer may automatically start.  Click on [Cancel] to

exit the installer and continue the operation.
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8 Click on [OK].

9 Select the printer driver that compatible to
your GA-1140 printer and click on [Next].
• When the GA-1140 printer is a US version, which the

default paper size type is LT system, select

“TOSHIBA e-STUDIO810srs-PCL6UC” (when you

install the PCL6 printer driver) or “TOSHIBA e-

STUDIO810srs-PS3UC” (when you install the

PostScript printer driver).

• When the GA-1140 printer is a European version,

which the default paper size type is A4 system, select

“TOSHIBA e-STUDIO810srs-PCL6EU” (when you

install the PCL6 printer driver) or “TOSHIBA e-

STUDIO810srs-PS3EU” (when you install the

PostScript printer driver).

7 Locate the directory where the printer driver
for Windows 95/98/Me is located, select the
“oemsetup.inf” file, and click on [OK].
• When you want to install the PCL6 printer driver,

locate “[CD-ROM drive]:\English\Prntdrvr\Pcl6_drvr

\Win_9x_ME”.

• When you want to install the PostScript printer driver,

locate “[CD-ROM drive]:\English\Prntdrvr\Ps_drvr

\Win_9x_ME”.

6 Click on [Browse...].
• The Locate File dialog box appears.
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11 Select “Yes” to print a test page and click on
[Finish].

10 Change the name if desired, select whether
using this printer as a default printer, and click
on [Next].

NOTE:

When installing the printer driver for Novell printing for Windows 95/98/Me, only one printer driver

can be installed for one print queue by operating the installation in this method.  If you want to

install another printer driver for Novell printing, install the printer driver by Add Printer Wizard and

set the NetWare print queue to the printer port.

 : The PS3 Upgrade (GE-1020) or PS3 Scan & HDD Upgrade (GE-1060+GE-1110) is required to

use the PostScript Driver.
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13 The printer driver is installed and the print
queue window appears.

12 Make sure a test page is printed successfully
and click on [Yes] to close the dialog box.

14 Continue the operation to configure the option
settings on the printer driver.

P59 “Configuring the Options”
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Windows NT 4.0/2000/XP

The procedure here describes an installation on Windows 2000.  The procedures are the same when

Windows NT 4.0 or Windows XP is used.

REQUIREMENTS:

• The NetWare server is configured correctly and running on your network.

• The TCP/IP protocol is installed and configured correctly on your Windows computer.

(Required only when using the NetWare server 5.x in the TCP/IP network.)

• The NWLink IPX/SPX Compatible Transport protocol and NWLink NetBIOS protocol (for

Windows NT 4.0) or NWLink IPX/SPX/NetBIOS Compatible Transport Protocol (for Windows

2000 and Windows XP) are installed on your Windows computer.  (Required only when using

the NetWare server in the IPX/SPX network.)

• The Gateway (and Client) Services for NetWare is installed on your Windows computer.

• You have an appropriate privilege to access to the NetWare server.

1 Open the NetWare server (when using in
bindery mode) or NDS directory tree (when
using in NDS or NDPS mode) in the Network
Neighborhood with the Windows Explorer, and
double-click on a queue.
• Select a queue depending on how you want to print.

[given name]_direct - print jobs are sent straight to

the printer without spooling.

[given name]_hold - print jobs are held until users

operate copying or moving them to the Print queue

with the job management tools.

[given name]_print - print jobs are spooled to the

hard disk in the GA-1140 printer and printed out.  Use

this queue for general printing.

• When using the NetWare 5.x in NDPS mode and the

printer drivers for each Operating System are

installed to a NDPS broker, the printer driver is

automatically installed.

• Unless using the NetWare 5.x in NDPS mode and

printer drivers for each Operating System are

installed to a NDPS broker, the Add Printer Wizard

dialog box appears.  Continue to the next step.
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3 Click on [OK].
• The Add Printer Wizard dialog box appears.

4 Click on [Have Disk...].
• The Install From Disk dialog box appears.

6 Click on [Browse...].
• When you are operating on Windows NT 4.0, the “A:\

is not accessible” message may appear.  When the

message is displayed, click on [Cancel] and continue

the operation.

• The Locate File dialog box appears.

5 Insert the User Software CD-ROM into the CD-
ROM drive.
• When inserting the User Software CD-ROM, the

installer may automatically start.  Click on [Cancel] to

exit the installer and continue the operation.

2 Click on [Yes].

SUPPLEMENT:

The queue names created on the NetWare server should be either “[given name]_direct”, “[given

name]_hold”, “[given name]_print” ([given name] can be any name).  Those queues correspond

to the GA-1140 printer’s queues, Direct, Hold, and Print.

 : The Hold queue and Print queue are only available when the PS3 Scan & HDD Upgrade (GE-

1060+GE-1110) is installed.
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8 Click on [OK].

7 Locate the directory where the printer driver
for your operating system is located, select the
“oemsetup.inf” file, and click on [Open].
• When you want to install the PCL6 printer driver for

Windows NT 4.0:

[CD-ROM drive]:\English\Prntdrvr\Pcl6_drvr\Win_NTx

• When you want to install the PostScript printer driver

for Windows NT 4.0:

[CD-ROM drive]:\English\Prntdrvr\PS_drvr\Win_NTx

• When you want to install the PCL6 printer driver for

Windows 2000:

[CD-ROM drive]:\English\Prntdrvr\Pcl6_drvr\Win_2000

• When you want to install the PostScript printer driver

for Windows 2000:

[CD-ROM drive]:\English\Prntdrvr\PS_drvr\Win_2000

• When you want to install the PCL6 printer driver for

Windows 2000:

[CD-ROM drive]:\English\Prntdrvr\Pcl6_drvr\Win_XP

• When you want to install the PostScript printer driver

for Windows 2000:

[CD-ROM drive]:\English\Prntdrvr\PS_drvr\Win_XP
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10 The printer driver is installed and the print
queue window appears.

NOTE:

When installing the printer driver for Novell printing for Windows NT 4.0, Windows 2000, or

Windows XP, only one printer driver can be installed for one print queue by operating the

installation in this method.  If you want to install another printer driver for Novell printing, install

the printer driver by Add Printer Wizard and set the NetWare print queue to the printer port.

11 Continue the operation to configure the option
settings on the printer driver.

P59 “Configuring the Options”

9 Select the printer driver that compatible to
your GA-1140 printer and click on [OK].
• When the GA-1140 printer is a US version, which the

default paper size type is LT system, select

“TOSHIBA e-STUDIO810srs-PCL6UC” (when you

install the PCL6 printer driver) or “TOSHIBA e-

STUDIO810srs-PS3UC” (when you install the

PostScript printer driver).

• When the GA-1140 printer is a European version,

which the default paper size type is A4 system, select

“TOSHIBA e-STUDIO810srs-PCL6EU” (when you

install the PCL6 printer driver) or “TOSHIBA e-

STUDIO810srs-PS3EU” (when you install the

PostScript printer driver).

 : The PS3 Upgrade (GE-1020) or PS3 Scan & HDD Upgrade (GE-1060+GE-1110) is required to

use the PostScript Driver.
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Configuring the Options

After you complete the installation of printer drivers, you should configure the option settings on the

printer driver.

There are two methods to configure the options;

• When the GA-1140 printer and your computer is not connected in the TCP/IP network, you can

configure the options manually.

P59 “Configuring the Options Manually”

• When the GA-1140 printer and your computer is connected in the TCP/IP network, you can

configure the options automatically obtaining the settings using the Two-Way Communication.

P64 “Configuring the Options Automatically”

Configuring the Options Manually

The instruction for configuring the options manually varies depending on the printer driver and the

Windows version that you use.

P60 “When configuring options in the PCL printer driver for all Windows version or PostScript printer

driver on Windows 95/98/Me”

P62 “When configuring options in the PostScript printer driver on Windows NT 4.0, Windows 2000,

or Windows XP”
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Optional Paper Feeder
This sets whether or not the large capacity feeder is installed.

Not installed - Select this when no large capacity feeder is installed.
External LCF - Select this when the Large Capacity Feeder (MP-4003A) is installed.

Finisher
This sets whether or not the finisher is installed.

Not Installed - Select this when no finisher is installed.
Finisher - Select this when the Finisher (MJ-1017) is installed.
Saddle Stitch Finisher - Select this when the Saddle Stitch Finisher (MJ-1018) is installed.

Punch Unit
This sets whether or not the hole punch unit is installed.  This can be selected when “Finisher”
or “Saddle Stitch Finisher” is selected at “Finisher”.

3 Set the options according to the printer’s
condition and click on [OK].

SUPPLEMENT:

You can check the optional device

configuration on the GA-1140 using the

TopAccess.

P184 “Checking GA-1140 Copier Status”

2 Click on the [Options] tab and click on [Option
Settings].
• The Option Settings dialog box appears.

1 Select the printer driver in the Printers folder and click on [File] and select [Properties]
(for Windows 95/98/Me) or [Document Defaults..] (for Windows NT 4.0) or [Printing
References...] (for Windows 2000 and Windows XP).
• The printer drivers properties dialog box appears.

When configuring options in the PCL printer driver for all Windows version or
PostScript printer driver on Windows 95/98/Me
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4 Click on [OK] to save settings.

Continue the operation to set the user
information on the printer driver.

P66 “Setting the User Information”

Not Installed - Select this when no hole punch unit is installed.
2 Hole Punch Unit - Select this when the 2 Hole Punch Unit (MJ-6003E) is installed.
2/3 Hole Punch Unit - Select this when the 2/3 Hole Punch Unit (MJ-6003N) is installed.
4 Hole Punch Unit (F) - Select this when the 4 Hole Punch Unit (F) (MJ-6003F) is installed.
4 Hole Punch Unit (S) - Select this when the 4 Hole Punch Unit (S) (MJ-6003S) is
installed.

Inserter
This sets whether or not the inserter unit is installed.

Not Installed - Select this when no inserter unit is installed.
Installed - Select this when the Inserter (MJ-7001) is installed.

Printer HDD
This sets whether or not the PS3 Scan & HDD Upgrade is installed.

Not Installed - Select this when no HDD unit is installed.
Installed - Select this when the HDD unit is installed.

When configuring the options for the PCL printer driver on Windows 2000/XP:

When setting the options on the Windows 2000/XP PCL printer driver, you must set the options

three different ways in the printer driver, otherwise the settings may not work properly.  You must

set the features equivalently on the dialog boxes which are displayed by following method:

• From the Printers window, right-click the printer icon and select Printing Preference.  Click the

Options tab in the dialog box and set the options.

• From the Printers window, right-click the printer icon, select Properties, and then click the

Printing Preferences button.  Click the Options tab in the dialog box and set the options.

• From the Printers window, right-click the printer icon, select Properties, click the Advanced tab,

and then click the Printing Default button.  Click the Options tab in the dialog box and set the

options.
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When configuring options in the PostScript printer driver on Windows NT 4.0,
Windows 2000, or Windows XP

1 Select the printer driver in the Printers folder.
Then click on [File] and select [Properties].
• When you are operating on Windows XP, open the

Printers and Faxes folder to access to the printer

driver.

• The printer driver properties screen appears.

2 Display the [Device Settings] tab and set the
options.
• When you are operating on Windows NT 4.0, select

the option under “Installable Options”, and select the

installed option from the list below to change the

settings.

• When you are operating on Windows 2000 or

Windows XP, select the option under “Installable

Options”, and select the installed option from the

drop-down list to change the settings.
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Optional Paper Feeder
This sets whether or not the large capacity feeder is installed.

Not installed - Select this when no large capacity feeder is installed.
External LCF - Select this when the Large Capacity Feeder (MP-4003A) is installed.

Finisher
This sets whether or not the finisher is installed.

Not Installed - Select this when no finisher is installed.
Finisher - Select this when the Finisher (MJ-1017) is installed.
Saddle Stitch Finisher - Select this when the Saddle Stitch Finisher (MJ-1018) is installed.

Punch Unit
This sets whether or not the hole punch unit is installed.  This can be selected when “Finisher”
or “Saddle Stitch Finisher” is selected at “Finisher”.

Not Installed - Select this when no hole punch unit is installed.
2 Hole Punch Unit - Select this when the 2 Hole Punch Unit (MJ-6003E) is installed.
2/3 Hole Punch Unit - Select this when the 2/3 Hole Punch Unit (MJ-6003N) is installed.
4 Hole Punch Unit (F) - Select this when the 4 Hole Punch Unit (F) (MJ-6003F) is installed.
4 Hole Punch Unit (S) - Select this when the 4 Hole Punch Unit (S) (MJ-6003S) is
installed.

Inserter
This sets whether or not the inserter unit is installed.

Not Installed - Select this when no inserter unit is installed.
Installed - Select this when the Inserter (MJ-7001) is installed.

Printer HDD
This sets whether or not the PS3 Scan & HDD Upgrade is installed.

Not Installed - Select this when no HDD unit is installed.
Installed - Select this when the HDD unit is installed.

3 Click on [OK] to save settings.
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Configuring the Options Automatically

1 Select the printer driver in the Printers folder and click on [File] and select [Properties].
• The printer drivers properties dialog box appears.

2 Click on the [Options] tab and click on [Auto
Settings].
• The Two-Way Communication dialog box appears.

3 Enter the IP address or DNS Name in the field.
Then click on [Update].
• It begins communicating to the GA-1140 printer via

network and obtain the option settings automatically.

4 Click on [OK] to save settings.

Continue the operation to set the user
information on the printer driver.

P66 “Setting the User Information”

You can configure the options automatically using the Two-Way communication.  The instruction for

configuring the Two-way communication varies depending on the printer driver and the Windows

version that you use.

When configuring Two-Way Communication in the PCL printer driver for all Windows
version or PostScript printer driver on Windows 95/98/Me



65

Installing U
ser

Softw
are on a

W
indow

s C
om

puter

When configuring Two-way Communication in the PostScript printer driver on
Windows NT 4.0, Windows 2000, or Windows XP

1 Select the printer driver in the Printers folder and click on [File] and select [Properties].
• The printer drivers properties dialog box appears.

2 Click on the [Configuration] tab.

Check the “Two-Way Communication” check
box and enter the IP address or DNS Name in
the field.  Then click on [Update].
• It begins communicating to the GA-1140 printer via

network and obtain the option settings automatically.

3 Click on [OK] to save settings.
Continue the operation to set the user
information on the printer driver.

P66 “Setting the User Information”

NOTE:

Please wait until the [Update] button will be

active after clicking on it.  The option

settings would not be obtained if you click

[OK] before the [Update] button becomes

active.
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Setting the User Information

After you complete the installation of printer driver and configuration of installable optional devices, you

have to enter your user information on the printer driver.

Once you enter the user information such as name and department code, the print jobs sent from your

printer driver can be managed by GA-1140.  For example, a network administrator can check the

number of copies to be printed from specific department member.  Also users can check who send the

print jobs from using the Touch Panel Display or monitoring tools.

1 Select the printer driver in the Printers folder.
Then click on [File] and select [Properties] (for
Windows 95/98/Me), select [Document
Defaults..] (for Windows NT 4.0), or [Printing
References...] (for Windows 2000 and Windows
XP).
• The printer drivers properties dialog box appears.

2 Click on the [User] tab and enter user name in
the “User Name” field.
• Up to 32 alphanumeric characters can be entered for

a user name.
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3 Click on [Set Department Code].
• The Set Department Code dialog box appears.

4 Enter the department code each field and click
on [Set].
• The department code always must be 5 digit code.

5 Click on [OK] to save settings.

NOTE:

The department code does not necessarily

required to be set for using the printer

driver.  Please ask your network

administrator for the department code

should be set or not.

When setting the user information for the PCL printer driver on Windows 2000/XP:

When setting the user information on the Windows 2000/XP PCL printer driver, you must set the

user information three different ways in the printer driver, otherwise the settings may not work

properly.  You must set the features equivalently on the dialog boxes which are displayed by

following method:

• From the Printers window, right-click the printer icon and select Printing Preference.  Click the

Options tab in the dialog box and set the user information.

• From the Printers window, right-click the printer icon, select Properties, and then click the

Printing Preferences button.  Click the Options tab in the dialog box and set the user

information.

• From the Printers window, right-click the printer icon, select Properties, click the Advanced tab,

and then click the Printing Default button.  Click the Options tab in the dialog box and set the

user information.
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The User Software CD-ROM contains printer description files for popular Windows applications.  Adobe

PageMaker do not support automatic installation of printer description files from the Printers Control

Panel.  To make the GA-1140 available in the Print and Page Setup dialog boxes of this application,

copy printer description files to the appropriate location.

Location of Printer Description Files in the User Software CD-ROM:
The printer description files for the GA-1140 is located in the following folder in the User Software CD-

ROM:

For Windows 95/98/Me: \English\Prntdrvr\PS_drvr\Win_9x_Me

For Windows NT 4.0: \English\Prntdrvr\PS_drvr\Win_NTx

For Windows 2000: \English\Prntdrvr\PS_drvr\Win_2000

For Windows XP: \English\Prntdrvr\PS_drvr\Win_XP

The extension of printer description file is “.ppd”.  Find the files of which extension is “.ppd” and copy

them into the appropriate location.

Location to copy Printer Description Files:
The location to copy the printer description file is different according to applications.  Please read the

manual for an application provided from the software vendor.

For example, the location to copy the printer description files of Adobe PageMaker is:

For PageMaker 6.0: \Pm6\Rsrc\Usenglish\PPD4

For PageMaker 6.5: \Pm65\Rsrc\Usenglish\PPD4

For PageMaker 7.0: \Program Files\Adobe\PageMaker 7.0\Rsrc\Usenglish\PPD4

Copying the Printer Description File for Windows
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The Agfa Monotype Font Manager 2000 allows you to install the Internal Fonts to your computer.  By

installing the Internal Fonts to your computer, you can displayed the Internal Fonts on your screen.

1 Click on [Next].
• The Select Components dialog box appears.

2 Click on [Next].
• Make sure both “Program Files” and “Fonts” are

checked before clicking on [Next].

• If you want to change the directory where the

program is installed, click on [Browse...] to change

the directory.

• Start copying files and the Status dialog box appears.

SUPPLEMENT:

When you checked “AFM” at the prompt of selecting the installed components during the

installation of printer drivers using the installer, or you run “Setup.exe” in the “Afm” folder of the

User Software CD-ROM, the Welcome dialog box appears.

Installing the Agfa Monotype Font Manager 2000
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3 Click on [OK].
• The Setup Complete dialog box appears.

4 Click on [Finish].
• Check on “Yes, review the Readme file now!” when

you want to view the Readme file.

5 Select “Yes, I want to restart my computer
now”, and click on [Finish].
• You must restart your computer to enable the

installed fonts and program.
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Installing User Software on a

Mac OS Computer

 : The PS3 Upgrade (GE-1020) or PS3 Scan & HDD Upgrade (GE-1060+GE-1110) is required

for printing from a Mac OS computer.
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About User Software for Mac OS
The following user softwares are included in the User Software CD-ROM:

 AdobePS 8.7 Printer Driver - enables to print to the GA-1140 from Mac OS computers; supports

special Fiery and PostScript 3 features.  The PS3 Upgrade option or PS3 Scan & HDD Upgrade option

should be installed on the GA-1140 in order to use the PostScript printer driver.

 PostScript Printer Description file (PPD) - enables the special printing features for the GA-1140

from a Mac OS computer.  The PPD files are automatically installed on you Mac OS computer by

installing the AdobePS printer driver from the User Software CD-ROM.  You can also manually copy

the PPD files in the User Software CD-ROM in case the AdobePS 8.7 printer driver or later has already

installed on your Mac OS computer.

Fonts - allow to view the fonts that correspond to the 136 built-in PostScript printer fonts on the GA-

1140 on your Mac OS computer.

Planning for Installation

The general steps for installing the User Softwares and setting up printing on a Mac OS computer are:

1. Install the AdobePS printer driver and PostScript Printer Description file and set up the GA-1140 in

the Chooser.

P73 “Installing the Printer Driver”

2. Install the printer and screen fonts.

P79 “Installing the Fonts”
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Installing the Printer Driver
About the Installation

Before installing the printer driver to your computer, read this section to understand about installation.

 : The PS3 Upgrade (GE-1020) or PS3 Scan & HDD Upgrade (GE-1060+GE-1110) is required

for printing from a Mac OS computer.

System Requirements

To install the printer drivers on a Mac OS computer, the following environments are required.

OS: Mac OS 8.6 to 9.2, MacOS X (Classic Mode only)

Memory: 16MB or more

Protocol: EtherTalk installed
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 : The PS3 Upgrade (GE-1020) or PS3 Scan & HDD Upgrade (GE-1060+GE-1110) is required

for printing from a Mac OS computer.

To install the printer driver to Mac OS computer, follow the procedure below:

• Installing the AdobePS 8.7 to your Macintosh computer.

P74 “Installing the AdobePS 8.7”

• Creating the PostScript printer for the GA-1140 printer on your Mac OS computer.

P76 “Creating the AdobePS Printer”

Installing the Printer Driver to Mac OS Computer

Installing the AdobePS 8.7 Printer Driver

NOTE:

If the AdobePS is already installed on your computer, please make sure the version of AdobePS

is 8.7 or later.  To check the version of AdobePS on your computer, select the AdobePS file

located in the “Extensions” folder under the “System Folder”. Then click on [File], select [General

Information] in [Get Info].  The information of the AdobePS file is displayed and you can check

the version of the AdobePS file.

When the version of AdobePS is earlier than 8.7:
If the version of AdobePS is earlier than 8.7, follow the procedure here and install the AdobePS

8.7 printer driver from the User Software CD-ROM.

If the version of AdobePS is later than 8.7,

When the version of AdobePS is later than 8.7:
You have to install the printer description files for the GA-1140 although you do not have to

install the AdobePS printer driver from the User Software CD-ROM.  To install the printer

description files to your Mac OS computer, simply copy the files located in the “English:Printer

Driver:Printer Descriptions” folder in the User Software CD-ROM into the “System

Folder:Extensions:Printer Descriptions” folder on your Mac OS hard drive.

1 Insert the User Software CD-ROM into the CD-
ROM drive.
• The User Software icon appears on the desktop.
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5 Click on [OK].

4 Click on [Replace].
• When the old version of AdobePS is already installed

on your computer, the message dialog box as shown

at right is displayed.  In this case, click on [Replace].

6 Click on [Restart].

3 Click on [Yes].

2 Open the “English” folder in the User Software
CD-ROM and double-click on “AdobePS 8.7
Installer” included in the “Printer Driver”
folder.
• The AdobePS 8.7 installation begins.
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Creating the AdobePS Printer

2 Select the AdobePS icon (and select the
AppleTalk zone if configured) and a GA-1140
Printer displayed in the list, and click on
[Create].
• Select a GA-1140 printer depending on how you

operate the printing.  ([Server Name] is a printer

name of GA-1140.)

[Server Name]_GA-1140_Direct - print jobs are sent

straight to the printer without spooling.

[Server Name]_GA-1140_Hold - print jobs are held

until users operate copying or moving them to the

Print queue with the job management tools.

[Server Name]_GA-1140_Print - print jobs are

spooled to the hard disk in the GA-1140 printer and

printed out.  Use this queue for general printing.

1 Click on apple menu and select [Chooser].
• The Chooser window appears.

 : The “[Server Name]_GA-1140_Hold” and “[Server Name]_GA-1140_Print” printers are only

available when the PS3 Scan & HDD Upgrade (GE-1060+GE-1110) is installed.

3 Select a PostScript Printer Description file to
be used and click on [Select].
• When the GA-1140 printer is a US version, and the

default paper size type is LT system, select

“TOSHIBA e-STUDIO810srs-PS3UC”.

• When the GA-1140 printer is a European version, and

the default paper size type is A4 system, select

“TOSHIBA e-STUDIO810srs-PS3EU”.
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4 Select each option according to the
configuration of the GA-1140 printer and click
on [OK].

Optional Paper Feeder
This sets whether or not the large capacity feeder is installed.

Not installed - Select this when no large capacity feeder is installed.
External LCF - Select this when the Large Capacity Feeder (MP-4003A) is installed.

Finisher
This sets whether or not the finisher is installed.

Not Installed - Select this when no finisher is installed.
Finisher - Select this when the Finisher (MJ-1017) is installed.
Saddle Stitch Finisher - Select this when the Saddle Stitch Finisher (MJ-1018) is installed.

Punch Unit
This sets whether or not the hole punch unit is installed.  This can be selected when “Finisher”
or “Saddle Stitch Finisher” is selected at “Finisher”.

Not Installed - Select this when no hole punch unit is installed.
2 Hole Punch Unit - Select this when the 2 Hole Punch Unit (MJ-6003E) is installed.
2/3 Hole Punch Unit - Select this when the 2/3 Hole Punch Unit (MJ-6003N) is installed.
4 Hole Punch Unit (F) - Select this when the 4 Hole Punch Unit (F) (MJ-6003F) is installed.
4 Hole Punch Unit (S) - Select this when the 4 Hole Punch Unit (S) (MJ-6003S) is
installed.

Inserter
This sets whether or not the inserter unit is installed.

Not Installed - Select this when no inserter unit is installed.
Installed - Select this when the Inserter (MJ-7001) is installed.

Printer HDD
This sets whether or not the PS3 Scan & HDD Upgrade is installed.

Not Installed - Select this when no HDD unit is installed.
Installed - Select this when the HDD unit is installed.
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6 Click on [OK].
• The current printer is set to the GA-1140 printer and

the GA-1140 printer icon displayed on the desktop.

5 Close the window.
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Installing the Fonts
The Fonts on the User Software CD-ROM includes screen and printer fonts that correspond to the 136

built-in PostScript printer fonts on the GA-1140.  The Font installer copies both kinds of fonts to the

System:Fonts folder on your hard disk.  To be available to applications, the screen fonts must remain in

the System:Fonts folder.  The printer fonts can be copied to a folder of your choice.

SUPPLEMENT:

In the System:Fonts folder, when displayed by Kind, screen fonts appear as type “Font Suitcase”

and PostScript printer fonts appear as type “PostScript™ font”.

1 Insert the User Software CD-ROM into the CD-
ROM drive.
• The User Software icon appears on the desktop.

2 Open the User Software CD-ROM and double-
click on “Fonts”.
• The Fonts dialog box appears.

3 Click on [Install].
• The Fonts installation begins.

4 Click on [Restart].
• Your Mac OS computer is restarted.
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Printing from Windows Computers
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Once you have installed the GA-1140 printer driver and set it to the proper port as described in the

section “Installing the Printer Driver” in the chapter “Installing User Software on a Windows Computer”,

you can print directly from most Windows applications.  Simply choose the Print command from within

your application.

You can print using the various functions by setting print options on the printer driver .

Printing from Application

1 Open a file and select [Print] from the [File]
menu of the application.
• The Print dialog box appears.

2 Select the GA-1140 printer driver to be used
and Click on [Properties].
• The printer properties dialog box appears.

SUPPLEMENT:

The procedures for displaying the properties dialog for the printer driver may be different

depending on the application that you are using.  See your application’s manual about displaying

the printer properties dialog box.

3 Setting the Print Options for each tab
according to how you want to print.
• Setting the print options varies depending on how you

want to print a document.  Please refer to “Setting Up

Print Options” about setting the print options on each

tab.  P90 “Setting Up Print Options”

• You can also set the print options using setting

profiles.  P84 “Setting Print Options Using Profile”
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SUPPLEMENT:

• The interface varies somewhat depending on whether you are using the PCL6 or PostScript

printer driver and the version of Windows operating system.

• Some settings are disabled when the printer properties dialog box is displayed from an

application.  P93 “Displaying the Printer Properties”

4 Click on [Apply] and [OK] to save the settings.

5 Click on [Print] to print a document.

NOTE:

Some options listed in the printer driver can also be set from an application (for example,

collation).  Using collation in the application may cause problems.  In these cases, use the driver

option to perform the function, rather than setting it from the application.  But depending on the

application, settings such as the orientation may need to be set in the application, or the printer

driver, or both.  The application may not set up the file properly for printing on the GA-1140 and

may also take longer to process.  In order to print properly from the application that you are

using, please see the section about printing in the application’s manual.
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Setting Print Options Using Profiles

Print option settings can be saved on your hard disk so you can easily load specifically configured

settings for a particular job.  Settings files can also be shared over a network, using the Import and

Export features.

In order to print a document using profiles, you should create saved settings first.  You can also modify

or delete the saved settings.

P85 “Creating Saved Settings”

P86 “Modifying Saved Settings”

P87 “Deleting Saved Settings”

Once you create saved settings, you can load the settings for a particular job to print a document.

P87 “Loading Saved settings”

You can also export print settings as a file on your hard disk to share the settings over a network.

P88 “Exporting Saved Settings”

Once you export saved settings on your hard disk, other network clients can import saved settings from

the exported file.

P89 “Importing Saved Settings”
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1 Configure the print options on each tab.
• Setting the print options varies depending on how you

want to print a document.  Please refer to “Setting Up

Print Options” about setting the print options on each

tab.  P90 “Setting Up Print Options”

2 Click on [Save] at the Profile group.
• The Profile dialog box appears.

3 Enter a setting profile name using a maximum
of 16 characters, and click on [OK].
• The name appears in the Profile pop-up menu.

Creating Saved Settings
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Modifying Saved Settings

1 Modify the print options on each tab.
• Setting the print options varies depending on how you

want to print a document.  Please refer to “Setting Up

Print Options” about setting the print options on each

tab.  P90 “Setting Up Print Options”

2 Click on [Save] at the Profile group.
• The Profile dialog box appears.

3 Confirm that the setting profile to be modified
is highlighted, and click on [OK]
• The Attention message appears.

4 Click on [OK].
• The modified setting is saved.
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1 Click on [Advanced] at the Profile group.
• The Profile List dialog box appears.

Deleting Saved Settings

2 Select the setting profile you want to delete
and click on [Delete].
• The Delete Profile message appears.

3 Click on [OK].
• The selected setting profile is deleted.

Loading Saved Settings

1 Select the setting profile you want to use.
• The printer driver automatically configured with the

saved settings you have selected.
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Exporting Saved Settings

1 Click on [Advanced] at the Profile group.
• The Profile List dialog box appears.

2 Select the setting profile you want to export
and click on [Export].
• The Save As dialog box appears.

3 Browse to the location where you want to save
the file, enter a file name in the “File name”
field, and click on [OK].
• The file name can be up to eight characters long (not

including the extension).  The file name does not

have to match the Settings Name.

• The setting profile is saved as a file.

SUPPLEMENT:

When several setting profiles are selected, the Save As dialog box appears for saving each

setting profile separately.
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Importing Saved Settings

1 Click on [Advanced] at the Profile group.
• The Profile List dialog box appears.

2 Click on [Import].
• The Save As dialog box appears.

3 Browse to the location of the saved settings
file you want to import, select the file, and click
on [OK].
• The settings profile is loaded from the file and added

to the Profile pop-up menu.

NOTE:

Importing saved watermark settings is not available.
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Setting Up Print Options
The printer can handle various printing situations by changing the Print Options settings on the Printer

Properties.

To determine which option should be changed to print a document as you desire, refer to the following:

General Settings required for every printing:
Output Tab : Paper Size, Paper Source, Orientation, Media Type, Number of Copies, Destination

P97 “Setting the Output Tab”

Adding the Binding Margin for printing:
Output Tab : Binding Margin

P97 “Setting the Output Tab”

Printing both sides of the paper (Duplex printing):
Output Tab : Duplex

P97 “Setting the Output Tab”

Sort printing/Group printing/Printing with Staples/Printing with Hole Punch:
Output Tab : Finishing

P97 “Setting the Output Tab”

Printing multiple pages per sheet (Layout printing):
Output Tab : Layout

P97 “Setting the Output Tab”

Enlarge/Reduce printing:
Output Tab : Enlarge/Reduce

P97 “Setting the Output Tab”

Inserting a Cover, Back Cover, and sheet between pages:
Cover/Insert Tab : Cover Sheet, Back Cover, Sheet Insertion

P103 “Setting the Cover/Insert Tab”

Printing a watermark:
Watermark Tab : Watermark

P106 “Setting the Watermark Tab”

Adjusting the shade of gray scale (for PCL6 only):
Print Quality Tab : Gray Scale

P109 “Setting the Print Quality Tab”
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Changing how TrueType fonts are printed:
Print Quality Tab : TrueType Options

P109 “Setting the Print Quality Tab”

Printing with Smoothing Function, Toner Save Mode:
Print Quality Tab : Use Smoothing Function, Toner Save Mode

P109 “Setting the Print Quality Tab”

Printing PS Information when an error occurs (for PS only):
PS Tab : Print PS Information

P112 “Setting the PS Tab”

Printing in specific PostScript Print Format (for PS only):
PS Tab : PostScript Output Format

P112 “Setting the PS Tab”

Printing a rotated image (for PS only):
PS Tab : Rotation Printing

P112 “Setting the PS Tab”

Printing a mirror image (for PS only):
PS Tab : Mirror Image Printing

P112 “Setting the PS Tab”

Printing a negative image (for PS only):
PS Tab : Negative Image Printing

P112 “Setting the PS Tab”

Printing a Private Job:
Private Tab : Private Job

P114 “Setting the Private Tab”

Printing a Stored Job:
Private Tab : Stored Job

P114 “Setting the Private Tab”

Setting optional devices:
Options Tab : Option Settings, Auto Settings

P116 “Setting the Options Tab”
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Printing a Tab Sheet (Tab Printing):
Options Tab : Tab Settings

P116 “Setting the Options Tab”

Setting user information:
User Tab : User Name, Department Code

P119 “Setting the User Tab”

Viewing the version information:
User Tab : Version Information

P119 “Setting the User Tab”

Viewing the current settings table:
Settings Tab : Settings

P120 “Setting the Settings Tab”

Viewing the current status of the paper:
Consumables Tab : Paper

P121 “Setting the Consumables Tab”
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Displaying the Printer Properties

There are two ways to display the printer’s properties.  Displaying and setting the printer properties

vary according to how the settings take effect for printing.  Also the tabs displayed vary depending on

how you display the printer properties.

SUPPLEMENTS:

• The Color Management tab is additionally displayed for Windows 98, Windows Me.

• For the PCL6 and PostScript printer driver Windows NT 4.0, Windows 2000, and Windows XP,

only the Output, Cover/Insert, Watermark, Print Quality, PS (for PS driver only), Private,

Options, User, Settings, and Consumables tabs are displayed.

Setting the print options by viewing the printer properties from the Printers folder within the Windows

Start menu will establish the initial values of the print options.  For example, the paper size setting you

most commonly use, optional device settings, user information settings, etc, are settings you will not

want to change every time you print.  It is convenient to set these print options as initial values.

How to display:
1. Click on [Start], [Settings], and select [Printers] (for  Windows 95/98/Me/NT 4.0/2000) or [Printers

and Faxes] (for Windows XP).

2. Select the GA-1140 printer, click on the [File] menu and select [Properties] (for Windows 95/98/Me),

[Document Defaults] (for Windows NT 4.0), or [Printing Preferences] (for Windows 2000/XP).

Tabs are displayed:
• PCL6 Printer Driver

General, Details, Sharing, Output, Cover/Insert, Watermark, Print Quality, Private, Options, User,

Settings, Consumables

• PostScript printer driver

General, Details, Sharing, Output, Cover/Insert, Watermark, Print Quality, PS, Private, Options,

User, Settings, Consumables

Setting Initial Values of Print Options
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Setting the print options by viewing the printer properties from the Print dialog box within an application

will establish the values for the current print job.  The print option settings specific to each print job are

set using this method.

How to display:
1. Click on the [File] menu and select [Print] on an application.

2. Select the GA-1140 printer driver to be used and Click on [Properties].

Setting Print Options for Each Print Job
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1

2

Details of Screen

3

4

5 6 7 8

1 Printer Name
Displays the name given to the printer driver when it is installed, or the name as it is displayed on the icon in the Printer
folder.

2 Menu Tabs
The menu items of the printer driver are displayed as tabs.  Clicking on a tab will display the contents of the selected tab.
The tabs displayed vary depending on the way the print properties are displayed.

Output Tab
You can specify the paper size, paper source, number of copies, orientation, binding margin,
media type, destination, duplex printing, sorting, stapling, layout printing, and enlarge/reduce
printing.

P97 “Setting the Output Tab”
Cover/Insert Tab

You can specify the settings for adding the cover sheet or sheet insertion.

P103 “Setting the Cover/Insert Tab”
Watermark Tab

You can specify a watermark to be printed on an image.

P106 “Setting the Watermark Tab”
Print Quality Tab

You can specify how to print drawings, pictures, and fonts.

P109 “Setting the Print Quality Tab”
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 PS Tab
You can specify the settings for PS features.  This setting tab is available only for the
PostScript printer driver.

P112 “Setting the PS Tab”
Private Tab

You can specify the settings for private printing or stored printing.

P114 “Setting the Private Tab”
Options Tab

You can specify the settings for installed optional devices and Tab print settings.

P116 “Setting the Options Tab”
User Tab

You can display the user information.

P119 “Setting the User Tab”
Settings Tab

You can display the current print settings.

P120 “Setting the Settings Tab”
Consumables Tab

You can display the consumables status.

P121 “Setting the Consumables Tab”

3 Profile
Print option settings can be saved on your hard disk so you can easily load specifically configured settings for a particular
job.  Settings files can also be shared over a network, using the Import and Export features.

P84 “Setting Print Options Using Profiles”

4 [Restore Defaults]
Click on this to restore the settings to the original factory defaults.

5 [OK]
Click on this to enter the input settings and complete the print options settings.

6 [Cancel]
Click on this to cancel the input settings and exit the print options settings.

7 [Apply]
Click on this to enter the input settings without closing the print options settings.

8 [Help]
Click on this to browse the HELP for the printer driver.
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Setting the Output Tab

The Output tab permits setting the paper and layout information print options.

1

2

3

4

9

5

6

7

11

12

10

1 Paper Size
This selects the size of paper for printing.
• A3 • 8.25x13* • Computer (10-1/8” x 14”)
• A4 • 11x17(LD) • 13inchLG (8-1/2” x 13”)
• A5 • Legal (8-1/2” x 14”) • 8.5SQ (8-1/2” x 8-1/2”)
• B4 • Letter (8-1/2” x 11”) • 8K (390 x 270 mm)
• B5 • Statement (5-1/2” x 8-1/2”) • 16K (270 x 195 mm)
*8.25x13 is same as FOLIO size paper described in the Copier’s Manual.

NOTE:
• The default paper size varies depending on the Windows Regional Setting or the version of printer driver you installed.

It is set to Letter when the Regional Setting of your operating system is English (United States) or installing the printer
driver for US version.  It is set to A4 when the Regional Setting is not English (United States) or installing the printer
driver for EU version.

2 Orientation
This sets the paper printing direction.
• Portrait - The document is printed in the portrait direction.
• Landscape - The document is printed in the landscape direction.

3 Paper Source
This selects the source for feeding paper.  Please select a paper source that correlates with the printing size.
• Auto Select - Automatically selects the paper set in the printer according to the printed document size.
• Upper Drawer - Paper is fed from the Upper Recording Paper Tray.
• Lower Drawer - Paper is fed from the Lower Recording Paper Tray.
• Tandem LCF - Paper is fed from the Tandem Large Capacity Feeder.
• External LCF - Paper is fed from the External Large Capacity Feeder, which is an option.  This cannot be selected when

the External LCF is not installed.
• Bypass (Short Edge) - Paper is fed from the Bypass Tray and fed from the short edge of paper.
• Bypass (Long Edge) - Paper is fed from the Bypass Tray and fed from the long edge of paper.

NOTE:
• The selectable values vary depending on the installable optional devices to be installed on the GA-1140 and configured

on the Options tab.

8
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• The Attention message is displayed when “Bypass (Short Edge)” or “Bypass (Long Edge)” is selected.
• When you want to perform Tab printing, please specify the Tab Settings option on the Options tab before specifying the

media type and paper source on the Output tab.
P116 “Setting the Options Tab”

4 Media Type
This sets the media type of the paper.
• Plain - Select this when printing on 20 lbs plain paper (64-80 g/m2 pain paper).
• Thick1 - Select this when printing on 24/28/32 lbs thick paper, 60 lbs cover sheet, or 90 lbs index sheet (up to 163 g/m2

thick paper).
• Thick2 - Select this when printing on 65 lbs cover sheet or 110 lbs index sheet (up to 209 g/m2 thick paper).
• Transparency - Select this when printing on transparent sheets.
• Tab Paper - This is automatically selected when the Tab Settings for Bypass have been set on the Options tab.

NOTE:
• The Media Type is only available when “Bypass (Short Edge)” or “Bypass (Long Edge)” is selected under Paper Source.
• When you want perform Tab printing, please specify the Tab Settings option on the Options tab before specifying the

media type and paper source on the Output tab. P116 “Setting the Options Tab”

5 Number of Copies
This sets the number of printed copies.
The setting range varies depending on the type of the printer driver and the Windows versions:
• For PCL6 Printer Driver

Windows 95/98/Me and Windows NT 4.0 : 1 to 9999
Windows 2000 and Windows XP: 1 to 9999

• For PostScript Printer Driver
Windows 95/98/Me and Windows NT 4.0 : 1 to 999
Windows 2000 and Windows XP: 1 to 9999

6 Destination
This selects the destination tray to be outputted.
• Auto Select - Select this to route the output to the tray which is configured for default destination tray on the GA-1140.
• Tray 1 - Select this to route the output to the upper tray of the Finisher.  This is available only when the Finisher is

installed and selected on the Option tab.
• Tray 2 - Select this to route the output to the lower tray of the Finisher.  This is available only when the Finisher is

installed and selected on the Option tab.

7 Binding Margin
This selects whether or not the Binding Margin is set to the paper to be printed.
• None - Select this to set no gutter on the paper.
• Left - Select this to set the gutter on the left side on the paper.  When this is selected, specify the width of the gutter at

the Binding Width option.
• Right - Select this to set the gutter on the right side on the paper.  When this is selected, specify the width of the gutter at

the Binding Width option.
• Top - Select this to set the gutter on the top of the paper.  When this is selected, specify the width of the gutter at the

Binding Width option.
• Center - This sets the gutter on the center of two sided page. When this is selected, specify the width of the gutter at the

Binding Width option.  This is available only when you select the Magazine Sort or Magazine Sort + Saddle Stitch at the
Finishing option.

8 Binding Width
Enter the width of binding margin when you elect to add a binding margin.  You can set the width from 0.39 to 2.00 inch in
units of 0.01 inch (10.0 to 50.8 mm in units of  0.1 mm).

NOTE:
• Only “None” or “Top”  is available when “Tablet” is selected for the Duplex option.
• Only “None”, “Left”, or “Right” is available when “Book” is selected for the Duplex option.
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• Images will be reduced to fit  within the remaining area other than the space taken for the added binding margin.
• In case binding margin is added to the enlarge/reduce printing, the image will be shifted to opposite side of the margin

taking the space of the binding margin into account.  Therefore, the part of the image on the opposite side of the margin
will be missing on the page if the image does not fit within the remaining area minus the margin area.

• Images will be reduced to fit within the remaining area after the binding margin takes its space from the center when
adding the binding margin to the magazine sort.

9 Duplex
Enables duplex printing (printing on both sides of paper) according to the type of binding for duplex-printed pages.
To enable duplex printing, check the box and click on the Duplex icon according to desired type of binding.  This option is
only to print on both sides of the paper.  If you want to bind the output with staples, you should set the finishing option as
well.
• Book - Select this to print both sides of the paper in vertically the same direction to be bound along the vertical side of the

paper so that the pages can be turned over right and left.

NOTE:
• The Duplex option is disabled when the Magazine Sort is selected at the Finishing option.
• The icons for Book and Tablet on the Duplex dialog box vary according to the orientation of a printed image.

10 Finishing
This sets how to sort the printed sheet when numerous copies are made for printing.  Also you can enable the output to be
stapled or hole punched.
To enable the finishing option, check the box and click on the Finishing icon to select desired type of finishing.
• Sort - Select this for sort-printing (1, 2, 3... 1, 2, 3...)

• Group - Select this for group-printing (1, 1, 1... 2, 2, 2... 3, 3, 3...)

1

2

Portrait

1 2

Landscape

1

2

Portrait

1

2

Landscape

• Tablet - Select this to print both sides of the paper with a vertical reversal to be bound along the horizontal side of the
paper so that the pages can be turned over up and down.

• Magazine Sort - Select this for booklet making.  The printer automatically performs sorting of the pages and prints two
pages of reduced image on one page on the both side of paper.  When you want to add the width of the binding margin on
the center, select “Center” at the Binding Margin option and enter the desired width of binding margin.  See the description
for the Binding Margin option for further details.

NOTE:
• The Magazine Sort printing on the PostScript printer driver for the Windows 2000 and XP is available only when the

PS3 Scan & HDD Upgrade is installed on the GA-1140.
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• Sort + Staple Upper Right - Select this to staple in the upper right and print.  The Finisher or Saddle Stitch Finisher is
required to enable this option.

• Sort + Staple Left (Double) - Select this to staple double in the left and print.  The Finisher or Saddle Stitch Finisher is
required to enable this option.

• Sort + Staple Top (Double) - Select this to staple double in the upper side and print.  The Finisher or Saddle Stitch
Finisher is required to enable this option.

• Magazine Sort + Saddle Stitch - Select this for booklet making with stapling in the center.  The printer automatically
performs sorting of the pages and print two pages of reduced image on one page on the both sides of the paper.  When
you want to change the width of binding margin in the center, select “Center” at the Binding Margin option and enter the
width of binding margin.  See the description about the Binding Margin option for further details.  The Saddle Stitch
Finisher is required to enable this option.

NOTE:
• The Magazine Sort + Saddle Stitch printing on the PostScript printer driver for the Windows 2000 and XP is available

only when the PS3 Scan & HDD Upgrade is installed on the GA-1140.

• Hole Punch Left - Check the Hole Punch box and select this to create holes on the left side and print.  This can not be
used in combination with “Magazine Sort”, “Sort + Staple Left (Double)”, “Sort + Staple Top (Double)”, and “Magazine Sort
+ Saddle Stitch”.  The Hole Punch unit is required to enable this option.

• Hole Punch Top - Check the Hole Punch box and select this to create holes on the upper side and print.  This can not be
used in combination with “Magazine Sort”, “Sort + Staple Left (Double)”, “Sort + Staple Top (Double)”, and “Magazine Sort
+ Saddle Stitch”.  The Hole Punch unit is required to enable this option.

• Sort + Staple Upper Left - Select this to staple in the upper left and print.  The Finisher or Saddle Stitch Finisher is
required to enable this option.
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Sort

Group

Magazine Sort

Hole Punch Left

Hole Punch Top

Sort + Staple Top (Double)

Magazine Sort + Saddle Stitch

Sort + Staple Upper Right

* The Finishing dialog box above a image when all optional devices installed and set at the Options tab.

NOTE:
• The Finishing dialog box displayed varies depending on the installed optional devices set on the Options tab.
• An Attention message is displayed when the stapled option or hole punch option is selected.

11 Layout
This sets the printing of multiple pages on one page.  The pages are reduced to fit the selected paper size automatically and
printed.
To enable layout printing, check the box and click on the Layout icon to select desired type of layout.
• 2 in 1 right order - Select this to print images from 2 pages arranged left to right (when the orientation is portrait) or from

top to bottom (when the orientation is landscape) on one page.
• 2 in 1 reverse - Select this to print images from 2 pages arranged right to left (when the orientation is portrait) or from

bottom to top (when the orientation is landscape) on one page.
• 4 in 1 right order landscape - Select this to print images from 4 pages arranged horizontally from the left and printed top

to bottom on one page.
• 4 in 1 right order portrait - Select this to print images from 4 pages arranged vertically from the top and printed left to

right on one page.
• 4 in 1 reverse landscape - Select this to print images from 4 pages arranged horizontally from the right and printed top to

bottom on one page.
• 4 in 1 reverse portrait - Select this to print images from 4 pages arranged vertically from the top and printed right to left

on one page.
• 6 in 1 - Select this to print images from 6 pages arranged horizontally from the left and printed top to bottom on one page.
• 9 in 1 - Select this to print images from 9 pages arranged horizontally from the left and printed top to bottom on one page.
• 16 in 1 - Select this to print images from 16 pages arranged horizontally from the left and printed top to bottom on one

page.

Sort + Staple Upper Left

Sort + Staple Left (Double)
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2 in 1 right order

2 in 1 reverse

4 in 1 right order landscape

4 in 1 right order portrait

4 in 1 reverse landscape

4 in 1 reverse portrait

6 in 1

9 in 1

16 in 1

* The Layout dialog box above a image when the orientation is portrait.

NOTE:
• The Layout dialog box displayed varies depending on the orientation selected.
• The layout printing is disabled when the Magazine Sort or Magazine Sort + Saddle Stitch is selected for the Finishing

option.

 : “2 in 1 reverse”, “4 in 1 right order portrait”, “4 in 1 reverse landscape”, “4 in 1 reverse portrait” are not available for
the PostScript printer driver.

12 Enlarge/Reduce
This changes the size of the printed image on the page.
• Actual Size - Select this to print in the same size as an actual image.
• Output Paper Size - Select this to enlarge or reduce an image to fit exactly in the selected paper size from the drop down

box on the right.
• Zoom - Select this to enter the zoom ratio manually to enlarge or reduce an image.  You can set any integer from 25 to

400(%) for the zoom ratio.  This is not available when you enable the Layout option, or the Magazine Sort or Magazine
Sort + Saddle Stitch is selected at the Finishing option.

NOTE:
• The watermark is also enlarged or reduced when you enable the watermark option.
• The Zoom option is disabled when the Magazine Sort or Magazine Sort + Saddle Stitch is selected in the Finishing

option and when Layout printing is performed.
• In case a binding margin is added to the enlarge/reduce printing, the image will be shifted to the opposite side of the

margin taking the space of the binding margin into account.  Therefore, the part of the image on the opposite side of the
margin will be missing on the page if the image does not fit within the area minus the margin area.

Enlarge/Reduce Correspondence Table

A3
A4
A5
B4
B5
Tabloid
Legal
Letter
Statement
8.25x13
Computer
13inchLG
8.5SQ
8K
16K

 A3 A4 A5 B4 B5 11x17(LD) Legal Letter Statement 8.25x13 Computer 13inchLG 8.5SQ 8K 16K

100 70 49 86 60 93 72 66 46 70 84 72 50 90 63
141 100 69 122 86 132 102 93 65 100 119 102 72 128 90
200 141 100 173 122 188 145 132 94 141 169 145 102 182 128
115 81 56 100 70 108 83 76 53 81 97 83 58 105 73
163 115 80 141 100 153 118 108 76 115 138 118 83 148 105
 97 68 48 84 59 100 76 64 49 74 82 76 49 90 62
117 83 58 102 71 121 100 78 60 92 100 92 60 109 75
137 97 68 118 84 129 100 100 64 97 118 100 76 125 90
194 137 97 168 118 199 154 129 100 150 164 152 100 180 125
127 89 63 110 77 130 102 84 64 100 107 100 64 118 81
115 81 56 100 70 108 83 78 53 81 100 83 60 105 75
127 89 63 110 77 129 100 84 64 97 107 100 64 118 81
137 97 68 118 84 129 100 100 64 97 118 100 100 125 90
107 75 53 93 65 103 79 71 51 77 91 79 54 100 68
152 107 75 131 93 143 110 103 71 107 131 110 79 138 100

Purpose
Paper Size
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Setting the Cover/Insert Tab

The Cover/Insert tab sets adding a cover sheet, back cover sheet, or a blank sheet between pages.

This is useful when you want to add or print a cover page on a different color or different size sheet of

paper.

1

2

3

1 Cover Sheet
This sets front cover printing.  This option allows you to insert or print a cover on a sheet fed from a different tray from the
Paper Source option selected on the Output tab.
To enable front cover printing, check on the box and select the printing method.  Also, select the location from where a cover
sheet is to be fed using the Paper Source drop down box.

Printing Method
This selects how you want to print a cover.
• Blank - Select this to insert a blank cover.
• Simplex - Select this to print the first page of printed image on a cover.
• Duplex - Select this to print the first two pages of printed image on the both sides of a cover.  This is available only when

the Duplex option is enabled, or Magazine Sort or Magazine Sort + Saddle Stitch is selected as the Finishing option on
the Output tab.

Paper Source
Select the location from which a cover sheet is to be fed when the Cover Sheet option is enabled.

NOTE:
• If “Simplex” is selected while duplex printing is performed, the first page is printed on the front side of the cover sheet

and back side of the cover will be blank.
• “Simplex” is not available when the Magazine Sort or Magazine Sort + Saddle Stitch is selected as the Finishing option

on the Output tab.
• The selectable values in the Paper Source drop down box vary depending on the optional devices installed on the GA-

1140 and configured on the Options tab.
• “Inserter” can be selected from the Paper Source drop down box only when “Blank” is selected at the Printing Method

drop down box.
• An Attention message is displayed when “Bypass (Short Edge)” or “Bypass (Long Edge)” is selected using the Paper

Source drop down box.
• When you select “Lower Drawer (Tab Paper)” or “Bypass (Tab Paper)” from the Paper Source drop down box, please

specify the Tab Settings option on the Options tab before specifying the media type and paper source on the Output
tab. P116 “Setting the Options Tab”
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2 Back Cover
This sets back cover printing.  This option allows you to insert or print a back cover on a sheet fed from a different tray from
the Paper Source option on the Output tab.
To enable back cover printing, check on the box and select the printing method.  Also, select the location from where a back
cover sheet is to be fed using the Paper Source drop down box.

Printing Method
This selects how you want to print a cover.
• Blank - Select this to insert a blank back cover.
• Simplex - Select this to print the last page of printed image on a back cover.
• Duplex - Select this to print the last two pages of printed image on both sides of a back cover.  This is available only

when the Duplex option is enabled on the Output tab.

Paper Source
Select the location from which a back cover sheet is to be fed when the Back Cover option is enabled.

NOTE:
• If “Simplex” is selected while duplex printing is performed, the last page is printed on the back side of the cover sheet

and front side of the cover will be blank.
• The Back Cover option is disabled when the Magazine Sort or Magazine Sort + Saddle Stitch is selected as the

Finishing option on the Output tab.
• The selectable values in the Paper Source drop down box vary depending on the optional devices installed on the GA-

1140 and configured on the Options tab.
• “Inserter” can be selected from the Paper Source drop down box only when “Blank” is selected at the Printing Method

drop down box.
• An Attention message is displayed when “Bypass (Short Edge)” or “Bypass (Long Edge)” is selected using the Paper

Source drop down box.
• When you select “Lower Drawer (Tab Paper)” or “Bypass (Tab Paper)” from the Paper Source drop down box, please

specify the Tab Settings option on the Options tab before specifying the media type and paper source on the Output
tab. P116 “Setting the Options Tab”

3 Sheet/Tab Insertion
This sets sheet or tab insertion printing.  This option allows you to insert a sheet or tab sheet between pages, or print a
specific page on a sheet fed from a tray other than the Paper Source option selected on the Output tab.  This option is
useful when you want to insert a blank sheet between chapters, or you want to print chapter cover pages on the different
paper.
To enable sheet insertion printing, check on the box and select the printing method.  Also, select the location from which a
back cover sheet is to be fed using the Paper Source drop down box.  Then, enter the page number you want to insert and
click on [Set].  The saved sheet insertion setting is added to the Information list.  Repeat the operation to add all the sheet
insertion settings that you require.  If the wrong sheet insertion setting is added to the Information list, you can delete the
setting by selecting the setting in the list and clicking on [Delete].  Also you can delete all sheet insertion settings by clicking
on [Delete All].

Printing Method
This selects how you want to print a cover.  You can select a different value for each sheet insertion setting for a print job.
• Blank - Select this to insert a blank sheet.
• Simplex - Select this to print the page specified in the Insert Page list box on a inserted sheet.
• Duplex - Select this to print two pages specified in the Insert Page list box on the both sides of a inserted sheet.  For

example, when you enter 5 at the Insert Page list box, page 5 and 6 are printed on the both sides of a sheet.  This is
available only when the Duplex option is enabled on the Output tab.

Paper Source
Select the location from which a sheet is to be fed for each sheet insertion setting when the Sheet Insertion option is
enabled.
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Insert Page
Enter the page number where the sheet is to be inserted.  When “Simplex” is selected from the Printing Method drop down
box, entered page will be printed on the inserted sheet.  When “Duplex” is selected from the Printing Method drop down box,
entered page and the next page will be printed on both sides of the inserted sheet.

[Set]
Click on this to save the sheet insertion setting and add it to the Information list.

[Delete]
Select the setting from the Information list and click on this to delete the setting from the Information list.

[Delete All]
Click on this to delete all settings from the Information list.

Information
Saved sheet insertion settings are displayed.

NOTE:
• The Sheet Insertion option is disabled when the Magazine Sort or Magazine Sort + Saddle Stitch is selected using the

Finishing option on the Output tab.
• The selectable values in the Paper Source drop down box vary depending on the optional devices installed on the GA-

1140 and configured on the Options tab.
• “Inserter” can be selected from the Paper Source drop down box only when “Blank” is selected at the Printing Method

drop down box.
• An Attention message is displayed when “Bypass (Short Edge)” or “Bypass (Long Edge)” is selected in the Paper

Source drop down box.
• When you select “Lower Drawer (Tab Paper)” or “Bypass (Tab Paper)” from the Paper Source drop down box, please

specify the Tab Settings option on the Options tab before specifying the media type and paper source on the Output
tab. P116 “Setting the Options Tab”

• If “Blank” is selected while duplex printing is performed, and you enter an even
page (which is printed on the back side of the paper when printing duplex) for
the Insert Page list box setting, the specified page will be blank. The desired
blank sheet is inserted next and the duplex printing continues from the next
page.

4
5

3
Blank

1
2

5
6

4

3

1
2

Blank

Blank

4
5

3

1
2

Blank Sheet

Blank

• If “Simplex” is selected for duplex printing, the specified page is printed on the
front side of the sheet and back side of the sheet will be blank.

• If “Simplex” is selected while duplex printing is performed, and you enter an
even page (which is printed on the back side of the paper when printing
duplex) for the Insert Page list box setting, the specified page will be blank.
The page is printed on the front side of the inserted sheet and the duplex
printing continues from the next page.

• If “Duplex” is selected while duplex printing is performed, and you enter an
even page (which is printed on the back side of the paper when printing
duplex) for the Insert Page list box setting, the specified page will be blank.
The specified page and the next page are printed on the inserted sheet and the
duplex printing continues from the next page.

6
7

4
5

3

1
2

Blank
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Setting the Watermark Tab

The Watermark tab permits the printing of a watermark over the image on the paper.

 : The Watermark tab is not available for the PostScript printer driver for Windows NT 4.0,

Windows 2000, and Windows XP.

1

2

3

4

5

6

1 Watermark
This selects the watermark to be used or edited.  The following values except “None” are the default watermarks that have
been registered in the printer driver.  New watermarks you create are added to the drop down box list in alphabet order.
• None - Select this if no watermark is desired.
The following default watermarks are also displayed in the drop down box:
• CONFIDENTIAL
• COPY
• DRAFT

2 Only Print Watermark on First Page
Check this to print a watermark only on the first page.  This setting will become available when any watermark is selected
from the Watermark drop down box.

3 Watermark Style
This selects how the watermark is printed.
• Transparent - Select this to print a watermark using transparent text.
• Solid - Select this to print a watermark using solid text.

: “Background” can be selected for the PostScript printer.  When “Background” is selected, the watermark text is
printed behind the contents of the printed image.  “Transparent” is not available for the PostScript printer driver.

4 [New]
Click on this to create a new watermark.  The Watermark Detail screen appears by clicking on this.  You can create up to 30
different watermarks (including “None” and default watermarks).

P107 “Watermark Detail Screen”
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5 [Edit]
Select a watermark from the Watermark drop down box and click on this to edit a watermark.  The Watermark Detail screen
appears by clicking on this.

P107 “Watermark Detail Screen”

6 [Delete]
Select a watermark from the Watermark drop down box and click on this to delete the desired watermark.

NOTE:
• The default watermarks can be deleted.  If you delete the default watermarks, they cannot be restored.
• “None” cannot be deleted.

2

3

1

1 Watermark Detail
You can create or edit the watermark in this option group.

Text
Enter the text of a watermark.  You can enter up to 32 alphanumeric characters.  When you are editing a watermark, the
selected watermark text is displayed in the field.

Fonts
Select a font to be used for the watermark text.

Size
Enter the font size for the watermark text.  The font size can be set from 8 to 400 pt in units of 1 pt.

Style
Select the font style for the watermark text.
• Regular - Select this to set the regular style to the text.
• Bold -  Select this to set the bold style to the text.
• Italic - Select this to set the italic style to the text.
• Bold Italic - Select this to set the bold and italic style to the text.

Watermark Detail Screen
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Darkness
Enter the percentage of shading for the watermark text.  The shading can be set from 0 (lightest) to 100 (darkest) in units of
1%.  You can also set the percentage of shading by moving the scroll bar.

Angle
Enter the degree of angle for rotating the watermark text.  The angle can be set from -180 to 180 degrees in units of 1
degree.  You can also set the degree of angle by moving the scroll bar.

[Save]
Click on this to save the new or edited watermark.

[Cancel]
Click on this to cancel creating a new watermark or editing a watermark and restores the previous screen values.

2 Watermark Image
The image of the new or edited watermark is displayed.  You can also adjust the position of the watermark by moving the
horizontal and vertical scroll bars.

3 Position
This permits setting the position of the watermark using numeric values.

X Offset
Enter the horizontal position of the watermark.  It can be set from -10.00 to 10.00 inch in units of 0.01 inch (-254.00 to
254.00 mm in units of 0.01 mm).

Y Offset
Enter the vertical position of the watermark.  It can be set from -10.00 to 10.00 inch in units of 0.01 inch (-254.00 to 254.00
mm in units of 0.01 mm).

[Center]
Click on this to center the watermark.
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The Print Quality tab permits setting the gray scale, TrueType font, Smoothing, and Toner Save print

quality options.

This control screen differs depending upon whether the PCL6 printer driver or the PostScript printer

driver is being used.

1

2

3

4

1 Gray Scale
This sets how to print gray scale images.
• Lighter - Select this to print gray scale lighter.
• Standard - Select this to print gray scale using the standard density.
• Darker - Select this to print gray scale darker.
• Manual Settings - Select this to manually set the gray scale settings.  When this is selected, click on [Gray Scale

Settings] to manually set the brightness or darkness of gray scale.

[Gray Scale Settings]
Click on this to set manually the brightness or darkness of gray scale.  This button is only available when “Manual Settings”
is selected at the Gray Scale drop down box.  When this is clicked, the Gray Scale Settings dialog box appears.  Set the
brightness or darkness of gray scale using the scroll bar and click on [OK] to save manual gray scale settings.

Setting the Print Quality Tab

PCL6 Printer Driver
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 : The PS3 Upgrade (GE-1020) or PS3 Scan & HDD Upgrade (GE-1060+GE-1110) is required to

use the PostScript Driver.

1

2

3

1 TrueType Options
This sets how to print TrueType fonts.  This option can be set only when setting the print options from the Printers folder.
This is not available when setting from an application.
• Always use TrueType Fonts - Select this to print the document the same as the print image shown on the screen.  All

TrueType fonts are extracted on the printer for printing.  When you select this, click on [Send Font As] to set the format for
TrueType fonts sent to the printer.  P111 “Send Font As”

• Use Font Substitution Table - Select this to substitute the TrueType fonts using the printer internal fonts according to
the settings of the font substitution table.  To edit the substitution table, click on [Edit Font Substitution Table] to edit the
font substitution settings for Windows 95/98/Me.  For Windows NT 4.0, Windows 2000, and Windows XP, the substitution
table can be edited on the Device Settings tab which can be displayed by selecting [Properties] in the [File] menu from the
Printers folder. P111 “Font Substitution Table”

NOTE:
The [Send Font As] and [Edit Font Substitution Table] buttons are available only for Windows 95/98/Me.  These buttons
are not displayed when you are using the PostScript printer driver on Windows NT 4.0, Windows 2000, and Windows XP.

PostScript Printer Driver

2 TrueType Options
This sets how to print the TrueType fonts.
• Download as TrueType - Select this to print a normal document at a high speed.  All TrueType fonts are extracted on the

printer for printing.
• Download as Bit Image - Select this to print the document as same as the print image shown on the screen.
• Use Printer Fonts - Select this to substitute the TrueType fonts with printer internal fonts for printing.  The print result

may differ from the print image on the screen.

NOTE:
Printing may not be performed the same as the print image even though “Download as TrueType” is selected.

3 Use Smoothing Function
Check the box to print the texts and graphics smoothly.

4 Toner Save Mode
Check the box to print in toner save mode.
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Send Font As
This sets to specify the format to send the TrueType fonts which are not substituted with their PostScript equivalents.

Send TrueType fonts as
Select the format of the TrueType fonts to be sent to the printer.
• Outlines - select this to send the TrueType fonts in scalable outline (Type 1)

format .  This is best for sending the TrueType fonts in large point sizes.
• Bitmaps - Select this to send the TrueType fonts in bitmap (Type 3) format.  This

is best for sending the TrueType fonts in small point sizes.
• Type 42 - Select this to send the TrueType fonts in Type 42 format.
• Don’t Send - Select this to not send the TrueType fonts to the printer.  Select this

only for advanced users using a sophisticated print spooler.

Threshold
Specify the pixel size of the font at which the PostScript printer driver should switch
from sending TrueType fonts in the Type 1 format to sending them in the Type 3
format.  The pixel size of fonts varies according to the printing resolution.

Favor system TrueType fonts
Check this to use system TrueType fonts instead of printer fonts when the same
font is found on both the computer and the printer.

Send PostScript fonts as
Select how the PostScript fonts is sent to the printer.  This option is effective only
when sophisticated print spoolers are used for printing or font cartridges are
installed on the printer.

Font Substitution Table
This table shows how each TrueType font is substituted.  You can edit the substitution setting for each TrueType font.

Windows 95/98/Me—To edit the substitution setting in the Font Substitution Table
dialog box, select the substitution setting that you want to edit from the list, and
select how the selected TrueType font is sent to the printer at the drop down box
below.  In the drop down list, the internal printer fonts and the type of format,
selected at the Send TrueType fonts option on the Send Font As dialog box, are
displayed.

Windows NT 4.0/2000/XP—To edit the substitution setting in the Device Settings
tab of the Printer Properties dialog box, click the substitution setting that you want to
edit from the list, and select how the selected TrueType font is sent to the printer
from the pop-up menu displayed.

Some TrueType fonts are set to be substituted to the internal printer fonts as
defaults.  The default values of the substitution table are below.

2 Use Smoothing Function
Check the box to print the texts and graphics smoothly.

3 Toner Save Mode
Check the box to print in toner save mode.

TrueType Font Printer Fonts

Arial Helvetica

Arial Narrow Helvetica-Narrow

Book Antiqua Palatino

Bookman Old Style Bookman

Century Gothic Avant Garde

Century Schoolbook New CenturySchlbk

TrueType Font Printer Fonts

Courier New Courier

Monotype Corsiva ZapfChancery

Monotype Sorts ZapfDingbat

Symbol Symbol

Times New Roman Times
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 : The PS tab is only for the PostScript printer driver.  The PS3 Upgrade (GE-1020) or PS3 Scan

& HDD Upgrade (GE-1060+GE-1110) is required to use the PostScript Driver.

The PS tab sets the PostScript features for printing.

6

3

4

5

2

1 Print PS Information
Check on this to print a PS error information page when any errors occur for printing.

NOTE:
This option is only available when displaying the Properties dialog box from the Printers folder.

2 PostScript Output Format
This selects the output format for printing.
• PostScript (optimized for speed) - Select this to print in the PostScript format optimized for speed.
• PostScript (optimized for portability-ADSC) - Select this to print in the PostScript format optimized to the Adobe

document structure standard.
• Encapsulated PostScript (EPS) - Select this to embed PostScript as an image within an application.
• Archive format - Select this to create a data stream file and use it as a PostScript file.  This format file cannot be printed

to the printer.

3 Rotation Printing
This allows you to perform rotation printing of an image.  This option is available only when the orientation is set to
landscape.
• 0 degree - Select this to not perform rotation printing.
• 180 degrees - Select this to perform rotation printing.

4 Mirror Image Printing
This allows you to perform mirror image printing of an image.
• Mirror - Select this to perform mirror image printing.
• Normal - Select this to not perform mirror image printing.

NOTE:
Mirror Image Printing option is not available for Windows NT 4.0, Windows 2000, and Windows XP.

Setting the PS Tab

1
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5 Negative Image Printing
This allows you to perform negative image printing of an image.
• Negative - Select this to perform negative image printing.
• Positive - Select this to not perform negative image printing.

NOTE:
Negative Image Printing option is not available for Windows NT 4.0, Windows 2000, and Windows XP.

6 FreeForm
This allows you set various features for the FreeForm option.

Create Master
Select when creating a master file for FreeForm.   When you want to create a master file, select the master number for the
created master file.
• None - Select this to not create a master file for FreeForm.
• 1 to 15 - Select the master number from 1 to 15 for the master file you will create.

Remove White PPT Background
Check this to remove the white Microsoft PowerPoint background when creating a master file for FreeForm.  This is effective
only when a master number is selected using the Create Master drop down box.

Use Master
Select whether printing variable data using the master file for FreeForm.   When you print variable data, select the master
number to be used for printing the variable data.
• None - Select this to not use a master file for printing.
• 1 to 15 - Select the master number to be used for printing the variable data.

 : The FreeForm is the optional function to print variable data documents.  In order to use the FreeForm option, the
PS3 Scan & HDD Upgrade (GE-1060+GE-1110) is required.  For further information about FreeForm option, please
refer to the Fiery Utilities Guide.
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The Private tab allows you to perform private printing and stored printing.

NOTE:

To perform Private printing and Stored printing, the User Name must be set on the User tab.  If

you have not set the User Name, please set it first.  P119 “Setting the User Tab”

1

2

1 Private Job
Check on this to print the current job as a private job.  The print job sent as a private job is saved in memory on the GA-
1140, and the print job is not printed until you activate printing from the Touch Panel Display of the copier.  This option is
useful when you want to print a confidential document because it can be secured using a password.  The user has to enter
the password to print the private job when activating printing from the Touch Panel Display of the copier.  See the section
“Printing a Private Job” for how to print a Private Job.

P148 “Printing a Private Job”

Password
When the password is set, asterisks are displayed in the field.  When you perform private printing, you have to set a
password.  To set a password, click on [Password Setting].

[Password Setting]
Click on this to set the password for a private job.  The Password Setting for Private Job dialog box appears. Enter the
password using any numeric key and click on [Set].  Alphabetic characters cannot be used for the password.  This password
is used to print a private job from the Touch Panel Display from the copier.

Setting the Private Tab



Printing from
W

indow
s C

om
puter

115

2 Stored Job
Check on this to print the current job as a stored job.  The print job sent as a stored job is saved in memory on the GA-1140,
and the print job is not printed until you activate printing from the Touch Panel Display of the copier.  This option is useful
when you do not want to print a job immediately, and when you want to print a proof copy for confirmation before printing
several copies.  Also this is useful for printing the files are that frequently printed since the Stored Job is remained in the
memory until you delete the job from the Touch Panel Display.  See the section “Printing a Stored Job” for how to print a
stored job.

P164 “Printing a Stored Job”

Stored Name
Enter the name of the stored job.  This name is displayed in the job list at the Touch Panel Display of the copier.
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The Options tab establishes the configurations for the optional devices installed on the GA-1140 and

Tab settings for the Tab Print function.

1

2

3

5

1 [Option Settings]
Click on this to manually configure the installed optional devices on the GA-1140.  The Option Settings dialog box is
displayed upon clicking on this.

P59 “Configuring the Options Manually”

NOTE:
This option can be set only when setting the print options from the Printers folder.  This is not available when setting from
an application.  Also this option is not available for the PostScript printer driver for Windows NT 4.0, Windows 2000, and
Windows XP.   When configuring the options on the PostScript printer driver for these version of Windows, you must set
the Device Settings tab. P63 “Configuring the Options Manually—When configuring options in the PostScript printer
driver on Windows NT 4.0, Windows 2000, or Windows XP”

Optional Paper Feeder
This sets whether or not the large capacity feeder is installed.
• Not installed - Select this when no large capacity feeder is installed.
• External LCF - Select this when the Large Capacity Feeder (MP-4003A) is

installed.

Finisher
This sets whether or not the finisher is installed.
• Not Installed - Select this when no finisher is installed.
• Finisher - Select this when the Finisher (MJ-1017) is installed.
• Saddle Stitch Finisher - Select this when the Saddle Stitch Finisher (MJ-1018)

is installed.

Punch Unit
This sets whether or not the hole punch unit is installed.  This can be selected when
“Finisher” or “Saddle Stitch Finisher” is selected under “Finisher”.
• Not Installed - Select this when no hole punch unit is installed.
• 2 Hole Punch Unit - Select this when the 2 Hole Punch Unit (MJ-6003E) is

installed.

Setting the Options Tab

4

6
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• 2/3 Hole Punch Unit - Select this when the 2/3 Hole Punch Unit (MJ-6003N) is
installed.

• 4 Hole Punch Unit (F) - Select this when the 4 Hole Punch Unit (F) (MJ-6003F)
is installed.

• 4 Hole Punch Unit (S) - Select this when the 4 Hole Punch Unit (S) (MJ-6003S)
is installed.

Inserter
This sets whether or not the inserter unit is installed.  This can be selected when
“Finisher” or “Saddle Stitch Finisher” is selected under “Finisher”.
• Not Installed - Select this when no inserter unit is installed.
• Installed - Select this when the Inserter (MJ-7001) is installed.

Printer HDD
This sets whether or not the PS3 Scan & HDD Upgrade is installed.
• Not Installed - Select this when no HDD unit is installed.
• Installed - Select this when the HDD unit is installed.

2 [Auto Settings]
Click on this to automatically configure the installed optional devices on the GA-1140.  This can be performed when the GA-
1140 is connected to the TCP/IP network.  The Two-Way Communication dialog box is displayed upon clicking on this.
Enter the IP address of DNS name in the field, and click on [Update] to automatically obtain the option configuration from the
GA-1140.
The “Update the Driver when opened” option enables to update the option settings on the printer driver every time you open
it, so you can always update the option settings from the GA-1140 when checking on this.

NOTE:
The [Auto Settings] button is not displayed on the PostScript printer driver for Windows NT 4.0, Windows 2000, and
Windows XP.  Instead of the Auto Settings option on this tab, you can configure the Auto Settings option on the
Configuration tab. P65 “Configuring the Options Automatically—When configuring Two-Way Communication in the
PostScript printer driver on Windows NT 4.0, Windows 2000, or Windows XP”

3 [Media Setting]
Click on this to specify the media type of the sheet which is fed from the Bypass tray.  The Media Setting dialog box is
displayed upon clicking on this.  This setting reflects on Media Type on the Output tab when “Bypass (Short Edge) or
Bypass (Long Edge) is selected in the Paper Source option on the Output tab.



118

5 [Inserter Settings]
Click on this to specify the paper size and media type for the Inserter.  The Inserter Settings dialog box is displayed when
clicking on this.  Specify this option when you want to insert or print a sheet using the Inserter.

6 Measurement Units
Select whether to use millimeters or inches when specifying options on the printer driver.

4 [Tab Settings]
Click on this to perform tab printing.  The Tab Settings dialog box is displayed upon clicking on this.  You can print a
document on a tab sheet using the tab print settings.  To perform tab print, specify the tray where the tab sheet is set and
enter the width of the tab and the amount by which the image will be shifted.  Tab print can be performed only from the
Bypass tray, or Lower Drawer.

Tab Settings can be specified for Bypass or Lower Drawer depending on
from which the tab sheet is fed.  Please refer to Copier’s Manual for
background information on Tab printing.

Tab Paper
Check on this to perform tab print from the Bypass tray or Lower Drawer.

Tab Width
Enter the width of the tab.  The tab width can be set:
Bypass: 0.47 - 0.67 per 0.01 inch (12.0 to 17.0 per 0.1 mm)
Lower Drawer: 0.39 to 0.79 per 0.01 inch (10.0 to 20.0 per 0.1 mm)

Image Shift Width
Enter the amount that the image will be shifted from the tab side.  The shift
width can be set from 0 to 1.2 inches in units of 0.01 inch (0 to 30 mm in
units of 0.1 mm).
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The User tab permits setting the user information such as the user name and department code.

1

2

3

1 User Name
Enter the user name.  This name is displayed for print jobs in the Print Job page of the TopAccess program. The user name
is required for printing private and stored jobs.

P66 “Setting the User Information”

NOTE:
This option can be set only when setting the print options from the Printers folder.  This is not available when setting from
an application.

2 Department Code
Click on [Set Department Code] to set this user’s department code.  Counter information can be managed for each
department code.  Please ask your network administrator for your department code.

P66 “Setting the User Information”

NOTE:
This option can be set only when setting the print options from the Printers folder.  This is not available when setting from
an application.

The Set Department Code dialog box is displayed when clicking on [Set Department Code].  Enter your department code in
the Department Code and Verify fields, and click on [Set] to save the department code.

2 [Version Information]
Click on this to display the version information of the printer driver.

Setting the User Tab
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The Settings tab displays the current settings information.

1

2

1 Settings
The current print settings are displayed.

2 [Restore Global Defaults]
Click on this to restore the default values for all tabs.

NOTE:
The user name, department code, option settings, created watermark, edited watermark, deleted watermark, and create
setting profiles are not restored.

Setting the Settings Tab
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The Consumables tab displays the current status of the paper in each tray.

1

2

1 Paper
The paper remaining status, paper size, and media type for each paper tray is displayed.

2 [Update]
Click this to update the consumable information.

NOTE:
The information on this tab is automatically obtained from the GA-1140 using Two-Way communication.  To obtain the
information from the GA-1140, please set the Auto Settings option.  Configuring the Two-Way communication varies
depending on the type of printer driver and version of Windows. P64 “Configuring the Options Automatically”

Setting the Consumables Tab

SUPPLEMENT:

The Consumables tab within the PostScript

printer driver for Windows 2000 and Windows

XP can view the Engine Status in addition to

the items noted above.
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Managing Fonts with Font Manager 2000
The Agfa Monotype Font Manager 2000 program can be used to manage your fonts in Windows.

It can:

• Search your local and network drives for fonts.

• Install and uninstall fonts in Windows.

• Remove fonts from your computer.

• Preview or print the fonts on your computer or network.

• Create font groups for personal or workgroup projects.

• Sort your fonts in a variety of ways, etc.

Available Font List

Font Groups

Installed Fonts List
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Searching Fonts

The first time you start Agfa Monotype Font Manager 2000, the Find Fonts dialog box appears

automatically. Before installing a font in Windows, you have to search the available fonts that can be

installed by Font Manager 2000.

1. Click on the “Fonts” menu and select “Search for Fonts...”.
• The Find Fonts dialog box appears.

2. Select which drive you want to search for fonts.
• Selected Drives - Select this to choose the one of the drives to search for fonts.
• All Drives - Select this to search on all drives to search for fonts.
• Selected Paths - Select this to enter the path to the drive to search for fonts. Enter the path to the drive you want to

search for fonts when you select this.

3. Click on [OK].
• When you select “Selected Drives”, Continue to the next step.
• When you select “All Drives”, skip to Step 6.
• When you select “Selected Paths”, skip to Step 6.

4. The Select Drives dialog box appears.

5. Select a drive to search for fonts from the list and click on [OK].

6. Searching for fonts begins. The Search for fonts... dialog box is displayed while searching for fonts.
• If you cancel to search for fonts, click on [Stop].

7. The searched fonts are displayed at the Available Font List list.

Installing Fonts in Windows

After searching the fonts, you can install them in Windows. Once the fonts are installed in Windows, the

fonts can be displayed on the dialog box in applications and printed by the machine.

1. Highlight the fonts you want to install in Windows from the “Available Font List”.

2. Click on the “Fonts” menu and select “Install”.

3. The fonts are installed in Windows and added to the installed fonts list.

Uninstalling Fonts in Windows

You can uninstall the fonts in Windows. Even if you uninstall the fonts from Windows, the source files of

the uninstalled fonts are not deleted from the drive.

1. Highlight the fonts you want to uninstall from Windows from the installed fonts list.

2. Click on the “Fonts” menu and select “Un-install”.

3. The fonts are uninstalled from Windows. The uninstalled fonts are added to the “Available Fonts

List”.
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Removing Fonts from the Computer

You can remove the fonts from your computer that no longer be required. Even if you uninstall the fonts

from Windows, the source files of the uninstalled fonts are not deleted from the hard drive. You can

remove the sources of the uninstalled fonts from your computer by this function.

Before removing the fonts, the fonts must be uninstalled from Windows first.

1. Highlight the fonts you want to remove from your computer in the installed fonts list.

2. Click on the “Fonts” menu and select “Remove Font”.

3. The Remove Fonts dialog box appears.

4. Check on the box for “Delete font(s) from the hard disk” and click on [OK].
• If you do not check on the checkbox for “Delete font(s) from the hard disk”, the source of the fonts are not deleted from

the hard disk. If you want to remove the fonts from the Available Font List but do not want to delete the source file, do not
check on this checkbox.

5. The source files of the fonts are deleted from the hard drive.

Preview Fonts

You can preview the fonts that are displayed in the Available Font List and the installed fonts list.

1. Highlight a font you want to preview from the Available Font List or the installed fonts list.

2. Click on “Fonts” menu and select “Preview”.

3. The Preview dialog box appears. The sample font is displayed on the dialog box.
• Point Size - You can select the point size of the sample font displayed.
• Normal Styles - When this is selected, the font is displayed in the normal face on the dialog box.
• All Styles - When this is selected, the font is displayed in all of the available font faces on the dialog box.

Creating a Font Group

You can create a group of fonts and give a descriptive name to the group. The created group can be

used to install or uninstall the fonts in Windows. This function can be used to configure the different

working scenarios of the fonts for each user.

1. Select the Font Groups folder and click on the “Fonts” menu and select “NewGroup...”.
• The New Group dialog box appears.

2. Enter the group name in the Group Name field.

3. In the All Available Fonts, expand each folders and select fonts that you want to add to the group.

4. Click on [Add>>].
• The selected fonts are added to the Fonts in Group list.
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5. Click on [OK].

6. The created group is added to the Font Groups list.

Sorting Fonts in the List

You can sort and change the order of fonts to be displayed in the Available Font List and installed fonts

list.

Sorting by Name
Click on the “Sort” menu and click on “Sort by Name”. The fonts are listed alphabetically by the font

family name.

Sorting by Font Type
Click on the “Sort” menu and click on “Sort by Font Type”. The fonts are grouped according to their

technology type (TrueType, Type 1, or screen bitmap) and within each group the names will be listed

alphabetically.

Inverting the alphabetical Order
The lists can be inverted by clicking on the “Sort” menu and click on “Inverse Sort”.
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Printing from Mac OS Computers

 : The PS3 Upgrade (GE-1020) or PS3 Scan & HDD Upgrade (GE-1060+GE-1110) is required

for printing from a Mac OS computer.
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Printing from Application
 : The PostScript option, PS3 Upgrade (GE-1020) must be installed on the GA-1140 to print from

a Mac OS computer.

Once you have installed the GA-1140 printer driver as described in the section “Installing the Printer

Driver” in the chapter “Installing User Software on a Mac OS Computer”, you can print directly from

most Mac OS applications.

Before you can print to the GA-1140 from applications, you must select the GA-1140 in the Chooser.

Then, using the Adobe PostScript printer driver and the correct PostScript Printer Description file

(PPD), you can control many GA-1140 printing features by specifying job settings from print dialog

boxes.

You can print using the various functions by setting print options on the printer driver .

Selecting the GA-1140 in the Chooser

2 Select the AdobePS icon (and select the
AppleTalk zone if configured) and a GA-1140
Printer displayed in the list.
• Select a GA-1140 printer depending on how you

operate the printing.  ([Server Name] is a printer

name of GA-1140.)

[Server Name]_GA-1140_Direct - print jobs are sent

straight to the printer without spooling.

[Server Name]_GA-1140_Hold - print jobs are held

until users operate copying or moving them to the

Print queue with the job management tools.

[Server Name]_GA-1140_Print - print jobs are

spooled to the hard disk in the GA-1140 printer and

printed out.  Use this queue for general printing.

1 Click on apple menu and select [Chooser].
• The Chooser window appears.
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 : The “[Server Name]_GA-1140_Hold” and “[Server Name]_GA-1140_Print” printers are only

available when the PS3 Scan & HDD Upgrade (GE-1060+GE-1110) is installed.

SUPPLEMENT:

Please make sure the button below the Select a PostScript Printer list becomes the [Setup...]

button.  When the Choose dialog box shows the [Create] button below the Select a PostScript

Printer list, this means you have not yet configure the printer for printing.  In this case, you must

first configure the printer with a PPD file for GA-1140 to enable the GA-1140 printing features for

printing.  P76 “Creating the AdobePS Printer”

3 Close the Chooser window.
• The GA-1140 remains selected as the current printer

until you choose a new printer in the Chooser.
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Setting Options and Printing from Mac OS Computers

In Mac OS applications, print options are set from both the Page Setup dialog box and the Print dialog

box.

1 Open a file and select [Page Setup] from the
[File] menu of the application.

2 In the dialog box that appears, make sure the
GA-1140 printer is selected at the Printer menu
and specify the Page Setup settings for your
print job.
• Setting the Page Setup varies depending on how you

want to print a document.  Please refer to “Setting Up

Print Options for Page Setup Dialog” about setting the

print options on each tab.

P131 “Setting Up Print Options for Page Setup

Dialog”

3 Click on [OK] to save the Page Setup settings.

4 Select [Print] from the [File] menu of the
application.

5 In the dialog box that appears, make sure the
GA-1140 printer is selected at the Printer menu
and specify the Print settings for your print
job.
• Setting the Print Setup varies depending on how you

want to print a document.  Please refer to “Setting Up

Print Options for Print Dialog” about setting the print

options on each tab.

P135 “Setting Up Print Options for Print Dialog”

6 Click on [Print] to print a document.
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Setting Up Print Options for Page Setup Dialog
The Page Setup dialog boxes can be displayed by selecting the [Page Setup] command from the [File]

menu of the application.

In the Page Setup dialog boxes, you can specify the Page Attribute settings, Watermark settings, and

PostScript Options settings.

NOTE:

The Page Setup dialog boxes vary across applications.

Page Attributes

1

2

3

4

1 Paper
This selects the size of paper for printing.
• A3 • 8.25x13* • Computer (10-1/8” x 14”)
• A4 • 11x17(LD) • 13inchLG (8-1/2” x 13”)
• A5 • Legal (8-1/2” x 14”) • 8.5SQ (8-1/2” x 8-1/2”)
• B4 • Letter (8-1/2” x 11”) • 8K (390 x 270 mm)
• B5 • Statement (5-1/2” x 8-1/2”) • 16K (270 x 195 mm)
*8.25x13 is same as FOLIO size paper described in the Copier’s Manual.

NOTE:
The default paper size varies depending on the PPD file you selected during the installation of printer driver.  It is set to
Letter when the US version is selected, and A4 when the EU version is selected.

3 Orientation
This sets the paper printing direction.
• Portrait - The document is printed in the portrait direction.
• Landscape - The document is printed in the landscape direction.

In the Page Attributes menu, you can specify the paper size, orientation, scale, and booklet option.
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Enlarge/Reduce Correspondence Table

A3
A4
A5
B4
B5
Tabloid
Legal
Letter
Statement
8.25x13
Computer
13inchLG
8.5SQ
8K
16K

 A3 A4 A5 B4 B5 11x17(LD) Legal Letter Statement 8.25x13 Computer 13inchLG 8.5SQ 8K 16K

100 70 49 86 60 93 72 66 46 70 84 72 50 90 63
141 100 69 122 86 132 102 93 65 100 119 102 72 128 90
200 141 100 173 122 188 145 132 94 141 169 145 102 182 128
115 81 56 100 70 108 83 76 53 81 97 83 58 105 73
163 115 80 141 100 153 118 108 76 115 138 118 83 148 105
 97 68 48 84 59 100 76 64 49 74 82 76 49 90 62
117 83 58 102 71 121 100 78 60 92 100 92 60 109 75
137 97 68 118 84 129 100 100 64 97 118 100 76 125 90
194 137 97 168 118 199 154 129 100 150 164 152 100 180 125
127 89 63 110 77 130 102 84 64 100 107 100 64 118 81
115 81 56 100 70 108 83 78 53 81 100 83 60 105 75
127 89 63 110 77 129 100 84 64 97 107 100 64 118 81
137 97 68 118 84 129 100 100 64 97 118 100 100 125 90
107 75 53 93 65 103 79 71 51 77 91 79 54 100 68
152 107 75 131 93 143 110 103 71 107 131 110 79 138 100

Purpose
Paper Size

3 Scale
This changes the size of the printed image on the page.  Enter the zoom ratio to enlarge or reduce an image.  You can set
any integer from 25 to 400(%) for the zoom ratio.

NOTE:
The watermark is also enlarged or reduced when you enable the watermark option.

4 Booklet
Check this for booklet making.  When check on this, select the booklet icon on the right whether the booklet is bound along
the vertical side of paper (left icon) or the horizontal side of paper (right icon).

NOTE:
When you performs the booklet printing, you must specify other print options properly.  To print a booklet, please refer to
“Appendix for Booklet Printing” P144.
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Watermark

In the Watermark menu, you can set to print a watermark.

1

2 3

4

5

6

1 How to Print a Watermark
Select how you want to print a watermark here.
• None - Select this to print no watermark.
• First - Select this to print the watermark only on the first page.
• All - Select this to print the watermark on all pages.

2 Type of Format
Select the format of the watermark when you set to print a watermark.
• PICT - Select this to use a PICT image for the watermark.  Please select the PICT image for the watermark at the

Watermark pop-up menu.
• EPS - Select this to use an EPS image for the watermark.  Please select the EPS image for the watermark at the

Watermark pop-up menu.
• TEXT - Select this to use text for the watermark.  Please select the text for the watermark at the Watermark pop-up menu.

Also you can create or edit the watermark by clicking on [Edit...].

NOTE:
The PICT images and EPS images that you create can be added to your computer as the watermark.  To add the PICT
images and EPS images that you create as watermarks, copy the image file to “System Folder:Preferences:Watermarks”
folder in your hard disk.

3 Watermark
Select the watermark to be printed.  The values in the pop-up menu vary depending on which type of the watermark you
selected.

4 [Edit...]
Select the text watermark and click on this to edit or create a watermark.

5 Foreground
Check this to print the watermark in front of the print image.

6 Save with Document
Check this to save the watermark settings with the document for future print jobs.
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PostScript Options

In the PostScript™ Options menu, you can set the mirror image printing, negative image printing, and

how the texts and graphics are printed.

1

2

1 Visual Effects
This sets the visual effects for printing.
• Flip Horizontal - Check on this to print a mirror image that flipped horizontally.
• Flip Vertical - Check on this to print a mirror image that flipped vertically.
• Invert Image - Check on this to print a negative image.

2 Image & Text
This sets how the texts and graphics are printed.
• Substitute Fonts - Check on this to substitute fonts for printing according to the Adobe PostScript printer driver features.
• Smooth Text - Check on this to print texts smoothly.
• Smooth Graphics - Check on this to print graphics smoothly.
• Precision Bitmap Alignment - Check this to reduce the distort of graphics.
• Unlimited Downloadable Fonts - Check on this when printing a document with downloading the large amount of fonts

data.  This can reduce errors for printing since printing is performed slowly to take enough time for downloading the fonts
data.
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The Print dialog boxes can be displayed by selecting the [Print] command from the [File] menu of the

application.

In the Print dialog boxes, you can specify the General settings, Background Printing settings, Cover

Page settings, Layout settings, Error Handling settings, PostScript settings, Printer Specific Options

settings, and Private settings.  (The Color Matching settings are not effective even though you can

select the Color matching in the pop-up menu.)

NOTE:

The Print dialog boxes vary across applications.

In the General menu, you can set the general print options such as number of copies, sort printing.

1

4

5

1 Copies
This sets the number of printed copies.  You can set any integer from 1 to 9999.
Also you can set how the output is sorted.

2 Collate
Check this for sort-printing (1, 2, 3... 1, 2, 3...)

3 Reverse order
Check this to print from the last page.

4 Pages
This sets the pages to be printed.
• All - Select this to print all pages.
• From - Select this to specify the pages to be printed.  Enter the page range in the From and To field.

5 Paper Source
This selects the source for feeding paper.  Please select a paper source that correlates with the printing size.
• All pages from - Select this to use the same paper source for all pages.  Select the paper source at the pop-up menu on

the right.
• First page from - Select this to use the different paper source for the first page from the remaining pages.  Select the

paper source for the first page at the pop-up menu on the right.
• Remaining from - Select the paper source for the remaining pages at the pop-up menu on the right when you select the

First page from option.

Setting Up Print Options for Print Dialog

General

2

3
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In the Background Printing menu, you can set how the print job is spooled.

1

2

1 Print in
This sets how the print job is spooled.
• Foreground (no spool file) - Select this to disable any operation on the computer until printing is completed.
• Background - Select this to enable any operation on the computer during printing.

2 Print Time
This sets the schedule for printing.
• Urgent - Select this to print a job immediately.
• Normal - Select this to print a job normally.
• Print at - Select this to specify the time that the print job is sent to the printer.  Specify the time and date when this is

selected.
• Put Document on Hold - Select this to hold the print job in the desktop print queue.  To send the print job held in the

desktop print queue, double-click the GA-1140 printer icon on the desktop and activate the print job.

In the Cover Page menu, you can set the cover page insertion.

1

2

Background Printing

Cover Page
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1 Print Cover Page
This sets how the cover page is inserted.
• None - Select this not to insert the cover page
• Before Document - Select this to insert the front cover page.  When this is selected, select the paper source at the Cover

Page Paper Source option.
• After Document - Select this to insert the back cover page.  When this is selected, select the paper source at the Cover

Page Paper Source option.

2 Cover Page Paper Source
Select the paper source for the cover sheet when you set to insert the cover sheet.
• Same as document - Select this to insert the cover sheet fed from the paper source same as other pages.
• Auto Select - Automatically selects the paper set in the printer for the cover sheet.
• Upper Drawer - The cover paper is fed from the Upper Recording Paper Tray.
• Lower Drawer - The cover paper is fed from the Lower Recording Paper Tray.
• Tandem LCF - The cover paper is fed from the Tandem Large Capacity Feeder.
• External LCF - The cover paper is fed from the External Large Capacity Feeder, which is an option.  This cannot be

selected when the External LCF is not installed.
• Bypass (Short Edge) - The cover paper is fed from the Bypass Tray and fed from the short edge of paper.
• Bypass (Long Edge) - The cover paper is fed from the Bypass Tray and fed from the long edge of paper.

In the Layout menu, you can set the layout printing.

1

1 Pages per sheet
This sets how many sheets are used to print a page, or how many pages are printed in one sheet.
• 6x6 sheets/pg - Select this to print one page is divided into 36 images and printed on the 36 sheets.
• 5x5 sheets/pg - Select this to print one page is divided into 25 images and printed on the 25 sheets.
• 4x4 sheets/pg - Select this to print one page is divided into 16 images and printed on the 16 sheets.
• 3x3 sheets/pg - Select this to print one page is divided into 9 images and printed on the 9 sheets.
• 2x2 sheets/pg - Select this to print one page is divided into 4 images and printed on the 4 sheets.
• 1 - Select this not to perform the layout printing.
• 2 pgs/sheet - Select this to 2 pages are printed on one sheet.
• 4 pgs/sheet - Select this to 4 pages are printed on one sheet.
• 6 pgs/sheet - Select this to 6 pages are printed on one sheet.
• 9 pgs/sheet - Select this to 9 pages are printed on one sheet.
• 16 pgs/sheet - Select this to 2 pages are printed on one sheet.

2 Layout direction
Select the direction for layouting the pages.

2

3

Layout
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3 Border
Select whether the border line is drawn for each page.  This is not available when the divided layout printing (printing a page
on multiple sheets) is set.
• None - Select this to draw no border line.
• Single hairline - Select this to draw single hairline for the border.
• Single thin line - Select this to draw single thin line for the border.
• Double hairline - Select this to draw double hairline for the border.
• Double thin line - Select this to draw double thin line for the border.

NOTE:
Please do not check the Print on Both Sides option.  This print option cannot work properly.  When you want to print on
both sides of paper, please use the Duplex option on the Printer Specific Options menu.

In the Error Handling menu, you can set how to notify when an errors occur.

1

1 If there is a PostScript™ error
Select how the printer driver notifies when errors occur.
• No special reporting - Select this not to notify errors.
• Summarize on screen - Select this to notify the summaries of errors on the screen.
• Print detailed report - Select this to print the details of errors.

In the PostScript Settings menu, you can set the printing format.

1

2

3

Error Handling

PostScript Settings

4
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1 Format
Select the format for the print job.
• PostScript Job - Select this to send the print job in the PostScript format.
• EPS Mac Standard Preview - Select this to save as a file in the EPS format with the 72-bit preview image.
• EPS Mac Enhanced Preview - Select this to save as a file in the EPS format with the QuickDraw PICT preview image.
• EPS No Preview - Select this to save the print job as a file in the EPS format with no preview.

NOTE:
When you select “EPS Mac Standard Preview”, “EPS Mac Enhanced Preview” and “EPS No Preview”, please change the
Destination to “File” to save as a file, because the GA-1140 cannot print the print jobs in those format.  Also, when you
select the EPS format, only the first page of the print job is saved as an EPS image.

2 PostScript Level
Select the PostScript level for the print job.
• Level 1, 2 and 3 Compatible - Select this to send the print job that is compatible to Level 1 PostScript printer.
• Level 2 Only - Select this to send the print job that is compatible to Level 2 PostScript printer.
• Level 3 Only - Select this to send the print job that is compatible to Level 3 PostScript printer.

NOTE:
The GA-1140 with the PS3 Upgrade or PS3 Scan & HDD Upgrade can be used as a PostScript Level 3 printer.

3 Data Format
Select the data format for the print job.
• ASCII - Select this to send the print job as an ASCII or text file.
• Binary - Select this to send the print job as an binary file.  You can reduce the data size compared with ASCII.

4 Font Inclusion
This sets how the fonts are included in the print job.
• None - Select this to send the print job without including the fonts.
• All - Select this to send the print job with including the all fonts.
• All But Standard 13 - Select this to send the print job with including the all fonts except 13 standard fonts that are

generally installed to most PostScript printer.
• All But Fonts in PPD file - Select this to send the print job with including the all fonts except fonts that are listed in the

PPD file.

In the Printer Specific Options menu, you can set the GA-1140 printer features.

Printer Specific Options

1

2
3

4
5

6
7

8

9

10
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1 Media Type
This sets the media type of the paper.
• Plain - Select this when printing on general plain paper.
• Thick 1 - Select this when printing on 24/28/32 lbs thick paper, 60 bls cover sheet, or 90 lbs index sheet (up to 163 g/m2

thick paper).
• Thick 2 - Select this when printing on 65 lbs cover sheet or 110 lbs index sheet (up to 209 g/m2 thick paper).
• Transparency - Select this when printing on transparent sheet.
• Tab Paper - Select this when printing on Tab sheet.

NOTE:
• When you select any other than “Normal” in this option, please select “Bypass (Short Edge)” or “Bypass (Long Edge)”

for Paper Source option in the General menu.
• When you select “Tab Paper” , please set the Tab settings in the Tab Printing menu.

2 Smoothing
Select whether or not to print the texts and graphics smoothly.
• Off - Select this not to use the Smoothing function.
• On - Select this to use the Smoothing function.

3 Finishing
This sets how to sort the printed sheet when numerous copies are made for printing.  Also you can enable the output to be
stapled, or made a hole on the paper.
• Sort - Select this for sort-printing (1, 2, 3... 1, 2, 3...)

• Sort + Staple Upper Left - Select this to staple in the upper left and print.  The Finisher or Saddle Stitch Finisher is
required to enable this option.

• Sort + Staple Upper Right - Select this to staple in the upper right and print.  The Finisher or Saddle Stitch Finisher is
required to enable this option.

• Sort + Staple Left (Double) - Select this to staple double in the left and print.  The Finisher or Saddle Stitch Finisher is
required to enable this option.

• Sort + Staple Top (Double) - Select this to staple double in the upper side and print.  The Finisher or Saddle Stitch
Finisher is required to enable this option.
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• Saddle Stitch - Select this to staple on the center.  This is useful when you print and create the booklet.  The Saddle
Stitch Finisher is required to enable this option.  In order to create a booklet, you must specify other print options properly.
To print a booklet, please refer to “Appendix for Booklet Printing” P144.

4 Duplex
Enables duplex printing (printing on both sides of paper) and the type of binding for the duplex-printed pages.
• Off - Select this not to perform the duplex printing.
• Long Edge Binding - Select this to bind along the long edge side of paper.  The direction to be printed on the back side

of the paper differs depending on the orientation.

1

2 1

2

Portrait Landscape

• Short Edge Binding - Select this to bind along the short edge side of paper.  The direction to be printed on the back side
of the paper differs depending on the orientation.

1

2

1 2

Portrait Landscape

5 Hole Punch
This sets to print using the hole punch.  This can create holes on the paper for binding using two hole binder.
• Off - Select this not to use the hole punch.
• Left - Select this to create holes on the left side and print.  This can not be used in combination with “Sort + Staple Left

(Double)”, “Sort + Staple Top (Double)”, and “Saddle Stitch” at the Finishing option.  The Hole Punch unit is required to
enable this option.

• Top - Select this to create holes on the upper side and print.  This can not be used in combination with “Sort + Staple Left
(Double)”, “Sort + Staple Top (Double)”, and “Saddle Stitch” at the Finishing option.  The Hole Punch unit is required to
enable this option.

6 Destination
This selects the destination tray to be outputted.
• Auto Select - Select this to route the output to the tray which is configured for default destination tray on the GA-1140.
• Tray 1 - Select this to route the output to the upper tray of the Finisher.  This is available only when the Finisher is

installed and selected on the Option tab.
• Tray 2 - Select this to route the output to the lower tray of the Finisher.  This is available only when the Finisher is

installed and selected on the Option tab.

• Group - Select this for group-printing (1, 1, 1... 2, 2, 2... 3, 3, 3...)
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7 Rotate 180 Degrees
This allows you to perform the rotation printing of an image.  This option is available only when the orientation is set to
landscape.
• No - Select this not to perform the rotation printing.
• Yes - Select this to perform the rotation printing.

8 Create Master
Select whether creating the master file for FreeForm.   When you want to create a master file, select the master number for
the created master file.
• None - Select this not to create a master file for FreeForm.
• 1 to 15 - Select the master number from 1 to 15 for the master file you will create.

9 Use Master
Select whether printing a variable data using the master file for FreeForm.   When you print a variable data, select the
master number to be used for printing the variable data.
• None - Select this not to use a master file for printing.
• 1 to 15 - Select the master number to be used for printing the variable data.

10 Remove White PPT Background
Select whether removing the white Microsoft PowerPoint background when creating a master file for FreeForm.  This is
effective only when the master number is selected at the Create Master drop down box.
• No - Select this not to remove the white Microsoft PowerPoint background.
• Yes - Select this to remove the white Microsoft PowerPoint background.

 : The FreeForm is the optional function to print variable data documents.  In order to use the FreeForm option, the
PS3 Scan & HDD Upgrade (GE-1060+GE-1110) is required.  For further information about FreeForm option, please
refer to the Fiery Utilities Guide.

Tab Printing

In the Tab Printing menu, you can perform the Tab printing.

1 Tab Paper
Check this when you want to print on the Tab sheet.  When this is checked, enter each tab settings value in the Width and
Shift field.

NOTE:
Tab printing can be perform only when the tab paper is fed from the Bypass tray or Lower Drawer.  If the selected Paper
Source is not set to “Lower Drawer” or “Bypass (Long Edge)”, the warning message is displayed.

1

2

3

4



143

P
rinting from

 M
ac

O
S

 C
om

puter

Private

In the Private menu, you can perform the Private printing and Stored printing.

1

2

1 Private Job Password
Check on this to print a current job as a private job.  When this is checked, enter the password in the User Entry field.
The print job sent as a private job is saved in the memory on the GA-1140, and the print job is not printed until you operate
printing from the Touch Panel Display of the copier.  This option is useful when you want to print a confidential document
because it can be secured using the password.  The user have to enter the password to print the private job when operate
printing from the Touch Panel Display of the copier.  See the section “Printing a Private Job” for how to print a Private Job.

P148 “Printing a Private Job”

2 Stored Job
Check on this to print a current job as a stored job.  When this is checked, enter the stored job name, and user name (and
department code if required) in the User Entry field.
The print job sent as a stored job is saved in the memory on the GA-1140, and the print job is not printed until you operate
printing from the Touch Panel Display of the copier.  This option is useful when you do not want to print a job immediately,
and when you want to print a proof copy for confirmation before printing several copies.  Also this is useful for printing the
files are that frequently printed since the Stored Job is remained in the memory until you delete the job from the Touch Panel
Display.  See the section “Printing a Stored Job” for how to print a stored job.

P164 “Printing a Stored Job”

3 User Name
Enter the user name.  This name is displayed as the user name of the print jobs on the TopAccesss Print Jobs pages and
the Touch Panel Display.  This must be set when you printing a private job or stored job.

4 Department Code
Enter the department code if required.  The department code is used when the Department Code setting is enabled on the
copier to manage the counter with the department code.  For the department code, please ask your department code
administrator.

3

4

2 Measurement Units
You can alter the unit from inch and mm used to set the Width and Shift option for the Tab printing.

3 Width
Enter the width of the tab when you check the Tab Paper box.
The tab width rage can be set varies depending on which you select for the paper source:
• Lower Drawer: from 0.39 to 0.79 inches in units of 0.01 inch (10.0 to 20.0 mm in units of 0.1 mm)
• Bypass (Long Edge): from 0.47 to 0.67 inches in units of 0.01 inch (12.0 to 17.0 mm in units of 0.1 mm)

4 Shift
Enter the width that a image will be shifted from the tab side.  The shift width can be set from 0 to 1.2 inches in units of 0.01
inch (0 to 30.0 mm in units of 0.1 mm).
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Appendix for Booklet Printing
When you want to print a booklet from the Mac OS computer, please follow the instruction here.

NOTE:

The following information does not always guarantee for that all applications can perform the

booklet printing from a Macintosh computer.

Printing a Portrait Booklet

1 Click on the [File] menu from an application,
and select [Page Setup].

2 Select the “Landscape” icon at “Orientation”.

3 Check the “Booklet” checkbox and select the
“Book” icon (left-side icon) for binding
direction.

4 Enter the scale to appropriate value depending
on the output paper size, and click on [OK].
• For Example;

Source paper size : LT (LT-R for Saddle Stitch)

Output paper size : LT

Scale : 64(%)

5 Click on the [File] menu from an application,
and select [Print].

SUPPLEMENT:

If you are printing from Microsoft Word, you should set the Microsoft Word options as well before

clicking on [OK] to accept settings on the Page Setup dialog.

P146 “When Printing from Microsoft Word”

When you want to print a booklet from a portrait document, follow the procedure below.
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7 Select “Printer Specific Options” at the drop
down box.

8 Select “Short Edge Binding” at the “Duplex”
drop down box and click on [Print].
• Printing a booklet with saddle stitch, you also need to

select the “Saddle Stitch” at the Finishing drop down

box.

1 Click on the [File] menu from an application,
and select [Page Setup].

2 Select the “Portrait” icon at “Orientation”.

3 Check the “Booklet” checkbox and select the
“Tablet” icon (right-side icon) for binding
direction.

4 Enter the scale to appropriate value depending
on the output paper size, and click on [OK].
• For Example;

Source paper size : LT (LT-R for Saddle Stitch)

Output paper size : LT

Scale : 64(%)

When you want to print a booklet from a landscape document, follow the procedure below.

Printing a Landscape Booklet

6 Check the “Reverse Order” checkbox.
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1.Under Page Setup, change the drop down box
from “Page Attributes” to “Microsoft Word”.

2.Select “whole document” at the “Apply Size and
Orientation To” drop down box.

3.Click on [OK].

When Printing from Microsoft Word:
If you are printing from Microsoft Word, follow the next 3 steps before clicking on [OK] to accept

settings on the Page Setup dialog.

7 Select “Printer Specific Options” at the drop
down box.

8 Select “Short Edge Binding” at the “Duplex”
drop down box and click on [Print].
• Printing a booklet with saddle stitch, you also need to

select the “Saddle Stitch” at the Finishing drop down

box.

SUPPLEMENT:

If you are printing from Microsoft Word, you should set the Microsoft Word options as well before

clicking on [OK] to accept settings on the Page Setup dialog.

P146 “When Printing from Microsoft Word”

5 Click on the [File] menu from an application,
and select [Print].

6 Check the “Reverse Order” checkbox.
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Printing a Private Job
The Private Job feature enables you to save jobs in the copier’s memory and edit and print them from

the Touch Panel Display at any time.

The Private Job is useful when you want to print a confidential document because it can be secured

using the password.

To print the Private Job, you should send the print job as the Private Job to the GA-1140 first.  The

Private Job can be printed from both the Windows computers and Mac OS computers.

Printing a Private Job from Computers

Creating a Private Job from Windows Computers

1 Open a file and select [Print] from the [File]
menu of the application.
• The Print dialog box appears.

2 Select the GA-1140 printer driver to be used
and Click on [Properties].
• The printer properties dialog box appears.

SUPPLEMENT:

The procedures for displaying the properties dialog for the printer driver may be different

depending on the application that you are using.  See your application’s manual about displaying

the printer properties dialog box.

3 Specify the print options that are required for
the print job at each tab, then click on Private
tab.
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4 Check “Private Job” and click on [Password
Setting].
• The Password setting for Private Job dialog box

appears.

5 Enter the 5 digit password using the Digital
keys in the “Password” and “Verify” field and
click on [Set].
• Only the numeric characters can be used for the

password.

• The password must be exactly 5 digits.

6 Click on [OK] to save settings.
• The screen returns to the Print dialog box.

7 Click on [Print].
• The print job is sent to the GA-1140 as a Private Job.

NOTE:

The Private Job option is disabled unless

the user name has been set on the User

tab.  If the option is grayed out, click on

User tab and enter the user name and try

again.
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Creating a Private Job from Mac OS Computers

 : The PS3 Upgrade (GE-1020) or PS3 Scan & HDD Upgrade (GE-1060+GE-1110) is required

for printing from a Mac OS computer.

1 Open a file and select [Page Setup] from the
[File] menu of the application.

2 In the dialog box that appears, make sure the
GA-1140 printer is selected at the Printer menu
and specify the Page Setup settings for your
print job.

3 Click on [OK] to save the Page Setup settings.

4 Select [Print] from the [File] menu of the
application.

5 In the dialog box that appears, make sure the
GA-1140 printer is selected at the Printer menu
and specify the Print settings for your print
job.  Then select the Private menu from the
pop-up menu.

SUPPLEMENT:

Before you can print to the GA-1140 from applications, you must select the GA-1140 in the

Chooser.  P128 “Selecting the GA-1140 in the Chooser”
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6 Check the box for the Private Job and enter the
5 digit password and user name in the User
Entry field.
• Only the numeric characters can be used for the

password.

• The password must be exactly 5 digits.

• Enter the Department Code if required.

7 Click on [Print].
• The print job is sent to the GA-1140 as a Private Job.



152

Printing a Private Job from Touch Panel Display

1 Press the [PRINTER/NETWORK] key on the
Control Panel of the copier.
• The PRINT menu or PRINT/SCAN menu is displayed

on the Touch Panel Display.

2 Press [PRIVATE].

3 Press your user name from the list.

Once you send the Private Job from the application, you can print the Private Job from the Touch

Panel Display on the copier’s Control Panel.  You can also print a proof of the Private Job, modify the

print settings, and delete the Private Job from the list.

P152 “Printing a Private Job”

P153 “Printing a Proof of the Private Job”

P155 “Modifying the Print Settings of the Private Job”

P162 “Deleting the Private Job”

Printing a Private Job
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4 Input the password using the Digital keys on
the Control Panel, and press [SET].

5 Select the Private Job that you want to print,
and press [PRINT].
• The Private Job is printed and removed from the

Private Job list.

Printing a Proof of the Private Job

1 Press the [PRINTER/NETWORK] key on the
Control Panel of the copier.
• The PRINT menu or PRINT/SCAN menu is displayed

on the Touch Panel Display.

2 Press [PRIVATE].
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3 Press your user name from the list.

4 Input the password using the Digital keys on
the Control Panel, and press [SET].

5 Select the Private Job that you want to print a
proof, and press [PROOF].
• One copy of the Private Job is printed and the Private

Job is remained in the list.
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Modifying the Print Settings of the Private Job

1 Press the [PRINTER/NETWORK] key on the
Control Panel of the copier.
• The PRINT menu or PRINT/SCAN menu is displayed

on the Touch Panel Display.

2 Press [PRIVATE].

3 Press your user name from the list.

4 Input the password using the Digital keys on
the Control Panel, and press [SET].
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5 Select the Private Job that you want to modify,
and press [MODIFY].
• The printer settings menu for selected Private Job is

displayed.

6 Press the upper left button to modify the
number of copies.
• If you do not have to modify the number of copies, go

to Step 8.

7 Highlight the field and enter the number of
copies using the Digital keys on the Control
Panel.  Then press [SET].
• Change the settings and the screen returns to the

print settings menu.
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8 Press the upper right button to modify the
Finishing option.
• If you do not have to modify the Finishing option, go

to Step 11.

9 Select the desired Finishing option button and
press [SET], or press [Next] to display more
finishing options.
• When you press [SET], save the settings and the

screen returns to the printer settings menu for

selected Private Job.  Go to Step 11.

• When you press [Next], the other finishing options

button will be displayed.  Go to Step 10.

NON-SORT NON-STAPLE
Select this button to print using no finishing features.

SORT
Select this button to print for sorting-printing when printing multiple copies.

GROUP
Select this button to print for group-printing when printing multiple copies.

SUPPLEMENT:

The [Next] button is disabled when the

Finisher or Saddle Stitch Finisher is not

installed on the copier.
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10 Select the desired Finishing option button and
press [SET].
• Save the settings and the screen returns to the print

settings menu.

SADDLE STITCH
Select this for booklet making with stapling on the center.  The printer automatically performs
sorting of the pages and print two pages of reduced image on one page on the both side of
paper.  The Saddle Stitch Finisher is required to enable this option.

NOTE:  The Saddle Stitch option should be used only if the original job was sent as Magazine
Sort and you want to print this file to the Saddle Stitch bin.

LEFT-UPPER SINGLE
Select this to staple in the upper left and print.  The Finisher or Saddle Stitch Finisher is
required to enable this option.

RIGHT-UPPER SINGLE
Select this to staple in the upper right and print.  The Finisher or Saddle Stitch Finisher is
required to enable this option.

LEFT DOUBLE
Select this to staple double in the left and print.  The Finisher or Saddle Stitch Finisher is
required to enable this option.
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TOP DOUBLE
Select this to staple double in the upper side and print.  The Finisher or Saddle Stitch Finisher
is required to enable this option.

11 Press the lower left button to modify the
Duplex printing option.
• If you do not have to modify the Duplex printing

option, go to Step 13.

12 Select the desired Duplex printing option
button and press [SET].
• Save the settings and the screen returns to the print

settings menu.

SIMPLEX
Select this not to perform the Duplex printing.

BOOK
Select this to print both side of paper in vertically the same direction to be bound along the
vertical side of paper that the pages can be turned over right and left.

1

2

Portrait

1 2

Landscape
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TABLET
Select this to print both side of paper a vertical reverse one to be bound along the horizontal
side of paper that the pages can be turned over up and down.

1

2

Portrait

1
2

Landscape

13 Press the lower right button to modify the Hole
Punch option.
• If you do not have to modify the Hole Punch option,

go to Step 15.

14 Select the desired Hole Punch option button
and press [SET].
• Save the settings and the screen returns to the print

settings menu.

NONE
Select this not to use the Hole Punch option.

LEFT
Select this to create holes on the left side and print.  This can not be used in combination with
“Magazine Sort”, “Sort + Staple Left (Double)”, “Sort + Staple Top (Double)”, and “Magazine
Sort + Saddle Stitch”.  The Hole Punch unit is required to enable this option.

SUPPLEMENT:

The Hole Punch option button is displayed

only when the Punch unit is installed on the

copier.
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TOP
select this to create holes on the upper side and print.  This can not be used in combination
with “Magazine Sort”, “Sort + Staple Left (Double)”, “Sort + Staple Top (Double)”, and
“Magazine Sort + Saddle Stitch”.  The Hole Punch unit is required to enable this option.

15 Press [TAB] to modify the Tab Print option.
• If you do not have to modify the Tab Print option, go

to Step 17.

16 Select either [CASSETTE] or [BYPASS FEED]
which the Tab sheets are fed from.

To change the tab margin and shift margin,
highlight the option and input the width using
the Digital keys.

Press [SET] when the you are finished
modifying the Tab Print option.
• Save the settings and the screen returns to the print

settings menu.

SUPPLEMENT:

You can print a proof for the current Tab

Print settings before saving the modified

settings.  In order to print a proof for the Tab

Print, press [TEST PRINT].

SUPPLEMENT:

The [TAB] button is displayed only when the

Tab Print option has been set to the print

job.



162

17 Press [Proof] if you want to print a proof of the
print job modified.
• If you do not have to print a proof, proceed to the

following step.

Press [Print] when you are finished modifying
your print job.
• The Private Job is printed and removed from the

Private Job list.

Deleting the Private Job

1 Press the [PRINTER/NETWORK] key on the
Control Panel of the copier.
• The PRINT menu or PRINT/SCAN menu is displayed

on the Touch Panel Display.

2 Press [PRIVATE].

3 Press your user name from the list.
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4 Input the password using the Digital keys on
the Control Panel, and press [SET].

5 Select the Private Job that you want to delete,
and press [DELETE].

6 Press [DELETE].
• The selected Private Job is deleted and removed

form the Private Job list.
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Printing a Stored Job
The Stored Job feature enables you to save jobs in the copier’s memory and edit and print them from

the Touch Panel Display at any time.

This option is useful when you do not want to print a job immediately.  Also this is useful for printing the

files are that frequently printed since the Stored Job is remained in the memory until you delete the job

from the Touch Panel Display.

To print the Stored Job, you should send the print job as the Stored Job to the GA-1140 first.  The

Stored Job can be printed from both the Windows computers and Mac OS computers.

Printing a Stored Job from Computers

Creating a Stored Job from Windows Computers

1 Open a file and select [Print] from the [File]
menu of the application.
• The Print dialog box appears.

2 Select the GA-1140 printer driver to be used
and Click on [Properties].
• The printer properties dialog box appears.

SUPPLEMENT:

The procedures for displaying the properties dialog for the printer driver may be different

depending on the application that you are using.  See your application’s manual about displaying

the printer properties dialog box.

SUPPLEMENT:

You can also print or delete the Stored Jobs using TopAccess.

P188 “Checking and Printing the Stored Job”

P189 “Checking and Deleting the Stored Job”
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4 Check “Stored Job”, enter the job name in the
“Stored Job” field, and click on [OK] to save
settings.
• The screen returns to the Print dialog box.

5 Click on [Print].
• The print job is sent to the GA-1140 as a Stored Job.

NOTE:

The Stored Job option is disabled unless

the user name has been set on the User

tab.  If the option is grayed out, click on

User tab and enter the user name and try

again.

3 Specify the print options that are required for
the print job at each tab, then click on Stored
tab.
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Creating a Stored Job from Mac OS Computers

 : The PS3 Upgrade (GE-1020) or PS3 Scan & HDD Upgrade (GE-1060+GE-1110) is required

for printing from a Mac OS computer.

1 Open a file and select [Page Setup] from the
[File] menu of the application.

2 In the dialog box that appears, make sure the
GA-1140 printer is selected at the Printer menu
and specify the Page Setup settings for your
print job.

3 Click on [OK] to save the Page Setup settings.

4 Select [Print] from the [File] menu of the
application.

5 In the dialog box that appears, make sure the
GA-1140 printer is selected at the Printer menu
and specify the Print settings for your print
job.  Then select the Stored menu from the
pop-up menu.

SUPPLEMENT:

Before you can print to the GA-1140 from applications, you must select the GA-1140 in the

Chooser.  P128 “Selecting the GA-1140 in the Chooser”
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6 Check the box for the Stored Job and enter the
stored name and user name in the User Entry
field.
• Enter the Department Code if required.

7 Click on [Print].
• The print job is sent to the GA-1140 as a Stored Job.
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Printing a Stored Job from Touch Panel Display

1 Press the [PRINTER/NETWORK] key on the
Control Panel of the copier.
• The PRINT menu or PRINT/SCAN menu is displayed

on the Touch Panel Display.

2 Press [STORAGE].

3 Select the Stored Job that you want to print,
and press [PRINT].

Once you send the Stored Job from the application, you can print the Stored Job from the Touch Panel

Display on the copier’s Control Panel.  You can also change the job name, modify the print settings,

and delete the Stored Job from the list.

P168 “Printing a Stored Job”

P169 “Changing the Stored Name”

P170 “Modifying the Print Settings of the Stored Job”

P177 “Deleting the Stored Job”

Printing a Stored Job
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4 If the Department Code screen is displayed,
input the department code for the Stored Job
using the Digital keys, and press [SET].
• The Stored Job is printed.

Changing the Stored Name

1 Press the [PRINTER/NETWORK] key on the
Control Panel of the copier.
• The PRINT menu or PRINT/SCAN menu is displayed

on the Touch Panel Display.

2 Press [STORAGE].

SUPPLEMENT:

The Stored Job is remained until you delete

the job.

3 Select the Stored Job that you want to edit the
name, and press [STORED NAME].
• The keypad screen is displayed.
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Modifying the Print Settings of the Stored Job

1 Press the [PRINTER/NETWORK] key on the
Control Panel of the copier.
• The PRINT menu or PRINT/SCAN menu is displayed

on the Touch Panel Display.

2 Press [STORAGE].

3 Select the Stored Job that you want to modify,
and press [MODIFY].

4 Enter the Stored Name with the screen for
entering letters and press [SET].
• The Stored Name is edited.
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5 Press the upper left button to modify the
number of copies.
• If you do not have to modify the number of copies, go

to Step 7.

4 If the Department Code screen is displayed,
input the department code for the Stored Job
using the Digital keys, and press [SET].
• The printer settings menu for selected Stored Job is

displayed.

6 Highlight the field and enter the number of
copies using the Digital keys on the Control
Panel.  Then press [SET].
• Change the settings and the screen returns to the

print settings menu.
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7 Press the upper right button to modify the
Finishing option.
• If you do not have to modify the Finishing option, go

to Step 10.

8 Select the desired Finishing option button and
press [SET], or press [Next] to display more
finishing options.
• When you press [SET], save the settings and the

screen returns to the printer settings menu for

selected Stored Job.  Go to Step 10.

• When you press [Next], the other finishing options

button will be displayed.  Go to Step 9.

SUPPLEMENT:

The [Next] button is disabled when the

Finisher or Saddle Stitch Finisher is not

installed on the copier.

NON-SORT NON-STAPLE
Select this button to print using no finishing features.

SORT
Select this button to print for sorting-printing when printing multiple copies.

GROUP
Select this button to print for group-printing when printing multiple copies.
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9 Select the desired Finishing option button and
press [SET].
• Save the settings and the screen returns to the print

settings menu.

SADDLE STITCH
Select this for booklet making with stapling on the center.  The printer automatically performs
sorting of the pages and print two pages of reduced image on one page on the both side of
paper.  The Saddle Stitch Finisher is required to enable this option.

NOTE:  The Saddle Stitch option should be used only if the original job was sent as Magazine
Sort and you want to print this file to the Saddle Stitch bin.

LEFT-UPPER SINGLE
Select this to staple in the upper left and print.  The Finisher or Saddle Stitch Finisher is
required to enable this option.

RIGHT-UPPER SINGLE
Select this to staple in the upper right and print.  The Finisher or Saddle Stitch Finisher is
required to enable this option.

LEFT DOUBLE
Select this to staple double in the left and print.  The Finisher or Saddle Stitch Finisher is
required to enable this option.
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11 Select the desired Duplex printing option
button and press [SET].
• Save the settings and the screen returns to the print

settings menu.

SIMPLEX
Select this not to perform the Duplex printing.

BOOK
Select this to print both side of paper in vertically the same direction to be bound along the
vertical side of paper that the pages can be turned over right and left.

1

2

Portrait

1 2

Landscape

10 Press the lower left button to modify the
Duplex printing option.
• If you do not have to modify the Duplex printing

option, go to Step 12.

TOP DOUBLE
Select this to staple double in the upper side and print.  The Finisher or Saddle Stitch Finisher
is required to enable this option.
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1

2

Portrait

1
2

Landscape

12 Press the lower right button to modify the Hole
Punch option.
• If you do not have to modify the Hole Punch option,

go to Step 13.

TABLET
Select this to print both side of paper a vertical reverse one to be bound along the horizontal
side of paper that the pages can be turned over up and down.

13 Select the desired Hole Punch option button
and press [SET].
• Save the settings and the screen returns to the print

settings menu.

NONE
Select this not to use the Hole Punch option.

LEFT
Select this to create holes on the left side and print.  This can not be used in combination with
“Magazine Sort”, “Sort + Staple Left (Double)”, “Sort + Staple Top (Double)”, and “Magazine
Sort + Saddle Stitch”.  The Hole Punch unit is required to enable this option.
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15 Select either [CASSETTE] or [BYPASS FEED]
which the Tab sheets are fed from.

To change the tab margin and shift margin,
highlight the option and input the width using
the Digital keys.

Press [SET] when the you are finished
modifying the Tab Print option.
• Save the settings and the screen returns to the print

settings menu.

SUPPLEMENT:

You can print a proof for the current Tab

Print settings before saving the modified

settings.  In order to print a proof for the Tab

Print, press [TEST PRINT].

14 Press [TAB] to modify the Tab Print option.
• If you do not have to modify the Tab Print option, go

to Step 16.

TOP
select this to create holes on the upper side and print.  This can not be used in combination
with “Magazine Sort”, “Sort + Staple Left (Double)”, “Sort + Staple Top (Double)”, and
“Magazine Sort + Saddle Stitch”.  The Hole Punch unit is required to enable this option.

SUPPLEMENT:

The [TAB] button is displayed only when the

Tab Print option has been set to the print

job.
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16 Press [Print] when you are finished modifying
your print job.
• The Stored Job is printed and removed from the

Stored Job list.

Deleting the Stored Job

3 Select the Stored Job that you want to delete,
and press [DELETE].

1 Press the [PRINTER/NETWORK] key on the
Control Panel of the copier.
• The PRINT menu or PRINT/SCAN menu is displayed

on the Touch Panel Display.

2 Press [STORAGE].
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4 Press [DELETE].
• The selected Stored Job is deleted and removed form

the Stored Job list.
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Tracking and Managing Print Jobs
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About the Print Job Management Tools
GA-1140 user software includes a variety of tools that allow you to track and manage print jobs.

Access to some tools is controlled by your site administrator, but other tools are available to all users.

• TopAccess provides the capability to view the flow of print jobs to the GA-1140.

 : There are also other print job management tools that are only available when the PS3 Scan &

HDD Upgrade (GE-1060+GE-1110) is installed on the GA-1140, such as the Command

WorkStation and Fiery WebTools.  For more about these tools, please refer to the Fiery Utilities

Guide.
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Managing the Print Jobs with TopAccess

TopAccess resides on the GA-1140 and can be accessed over the network from a variety of platforms.

TopAccess has a home page that lets you view server functions and manipulate jobs remotely. This

chapter describes those functions available to all users (not administrator function).

About TopAccess

Requirements

In order to use the TopAccess, the following environments are required.

• Either the Netscape Communicator v4.5 or later with Java enabled, or Microsoft Internet Explorer

v4.0.1 (with Service Pack 1) or later with Java enabled, installed on your computer.

• Monitor and video memory should support 16-bit color at a minimum resolution of 800 x 600.

• Your computer and the GA-1140 are connected to a TCP/IP enabled network.

• The TCP/IP is correctly set up on the GA-1140.

NOTE:

Netscape and Internet Explorer continue to release frequent updates to these browser.  As

support cannot be guaranteed for all versions, use the version specified above for best results.
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Accessing the TopAccess

1 Start the Internet browser on your computer.

2 Enter “http://[IP address or DNS name]” in the
Address entry field of the browser, and press
[Enter].
• Enter the IP address or DNS name assigned to the

GA-1140 instead of [IP address or DNS name].

3 The TopAccess home page appears.

SUPPLEMENT:

Ask your administrator for the IP address of DNS name of the GA-1140.
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5

Screen Details

1

2

3

4

1 Select Language

Select the language in which TopAccess will be displayed.
2 Menu

Click the menu link to access to each function.  Upon clicking on each menu item, the page

displayed in the Operation Area will change.
3 Status Display

Indicates the communication status and machine status.
4 Function Tab

Click the tab to access to each function among the pages displayed in the Operation Area.  Upon

clicking on each tab, the page displayed in the Operation Area will change.
5 Operation Area

Display the details of the page that you access by clicking on the menu and function tab.
6 TOSHIBA MFP Logo

Go to the TOSHIBA TEC Web site by clicking on this.  Update information about TOSHIBA TEC

products is available on this Web site.

6
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Checking GA-1140 Copier Status

You can use TopAccess to see which options are installed on your copier and to view paper levels.

The information is dynamically updated every time you access to this page.

1 Click the Copier Configuration menu.

SUPPLEMENT:

You can access the administrator specified web page (see Administrator’s Guide) by clicking on

the TOSHIBA MFP log located in the lower right corner of this page.  The Toshiba Copiers World

Wide Homepage (http://www.toshibatec.co.jp/joho/copier/english/index.html) is displayed as a

default setting.

Copier Configuration menu

2 The Configuration page is displayed.  You can
check the copier status such as what optional
devices are installed on the copier, the paper
sizes, and remaining paper status for each
feeder.
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Checking and Managing GA-1140 Print Jobs

You can use TopAccess to see what jobs are currently printing and the Private Jobs and Stored Jobs

currently saved in the GA-1140.  You can also print or delete these print jobs.  The information is

dynamically updated every time you access this page.

Checking and Deleting the Jobs Currently Printing

1 Click the Print Jobs menu.
• The Job Status page is displayed.  You can check the

jobs currently printing and jobs currently wait for

printing.

• When you want to delete the jobs in the list, proceed

to the next step.

2 Click the button in the Delete column for the
job that you want to delete.

Delete button

3 Click on [DELETE].

Print Jobs menu
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4 The job is deleted and the “Request Has Been
Received” message is displayed.

NOTE:

The job that is currently printing cannot be

deleted.

Checking and Deleting the Private Job

1 Click the Print Jobs menu and Private Job tab.
• The Private Job page is displayed.  You can check

the Private Jobs currently saved.

• When you want to delete a Private Job in the list,

proceed to the next step.

2 Click the button in the Delete column for the
job that you want to delete.

Delete button

Print Jobs menu Private Job tab
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4 Click on [DELETE].

3 Enter the password for the Private Job and
click on [OK].

5 The job is deleted and the “Request Has Been
Received” message is displayed.
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Checking and Printing the Stored Job

1 Click the Print Jobs menu and Stored Job tab.
• The Stored Job page is displayed.  You can check

the Stored Jobs currently saved.

• When you want to print a Stored Job in the list,

proceed to the next step.

2 Click the button in the Print column for the job
that you want to print.

Print button

3 Modify the print settings and enter the
department code in the Department field if
required.  Then click on [Print].

Print Jobs menu Stored Job tab
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4 The job is printed and the “Request Has Been
Received” message is displayed.

Checking and Deleting the Stored Job

1 Click the Print Jobs menu and Stored Job tab.
• The Stored Job page is displayed.  You can check

the Stored Jobs currently saved.

• When you want to delete a Stored Job in the list,

proceed to the next step.

2 Click the button in the Delete column for the
job that you want to delete.

Delete button

Print Jobs menu Stored Job tab
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4 The job is deleted and the “Request Has Been
Received” message is displayed.

3 Click on [DELETE].
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Checking GA-1140 Printer Settings

You can use TopAccess to see the current printer default settings that are effective for print jobs that

do not contain the print information.  You can also check the default font settings for PCL jobs, default

settings for PostScript jobs, and default settings for queues which are available when the HDD option is

installed.

1 Click the Printer Information menu and click
on either Printer, PCL, or PS tab.

 : PS tab is only available when

the PostScript option, PS3

Upgrade (GE-1020), is installed

on the GA-1140.

• When the Printer tab is clicked, you can

check the default settings for printer related

functions.

• When the PCL tab is clicked, you can check

the default settings for PCL related

functions.

• When the PS tab is clicked, you can check

the default settings for PostScript related

functions.

• When the Queue tab is clicked, you can

check the available queues on the GA-

1140.

 : Queue tab is only available

when the HDD option, PS3 &

HDD Upgrade (GE-1060), is

installed on the GA-1140.
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Displaying the Department Counter

When the Department Code is enabled on the copier settings, users can view the counter information

for each department code using TopAccess.

1 Click the Counter menu.
• The Enter Department Code page is displayed.

2 Enter the 5-digit department code of which you
want to view the counter and click on [OK].
• The Department Counter page is displayed.

NOTE:

If the department code is disabled, the

Counter menu is not displayed.

SUPPLEMENT:

Users who know the master code for the department code feature can set, edit, delete or export

the counter information on the copier. P194 “Managing the Counter with Master Code”

Counter menu
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3 Check the department counter or click on
[PRINT] to print the department counter
information sheet.
• “Printing Counter” shows the number of copies

printed on the copier:

Total Print - displays the total number of copy, other,

and print jobs that have been printed.

Copy -  displays the number of copy jobs that have

been printed.

Other - displays the number of printing other than

copy or print jobs.

Printer - displays the number of print jobs that have

been printed.

• “Department counter for printing” shows the number

of copies that have been printed for selected

department code.

• “Scanning Counter” shows the number of scans that

have been performed:

Total Scan -  displays the total number of scans that

have been performed.

Copying - displays the number of scans that have

been performed to print copies.

Scan - displays the number of scans that have been

performed to retrieve scanning images to the optional

hard disk or network client PC.



194

Managing the Counter with Master Code

If you know the master code for the department code, you can view the counters for all department

codes and perform the management functions for the counters, such as registering new department

codes, editing or deleting department codes, and resetting the department code counters.  In addition,

you can export the department counter information as a file on your local hard disk.

1 Click the Counter menu.
• The Enter Department Code page is displayed.

2 Enter the 5-digit department code whose
counter you wish to view and click on [OK].
• The Department Counter page is displayed.

NOTE:

If the department code is disabled, the

Counter menu is not displayed.

3 Continue the desired operation.
P195 “Registering a New Department Code”

P196 “Editing a Department Code”

P197 “Resetting a Department Counter”

P198 “Deleting Department Counter Information”

P199 “Exporting Counter Information”

Counter menu
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Registering a New Department Code

1 Click on [ADVANCED] on the Department
Counter page.

2 Click the button in the “Change” column of an
unused Dept Code.
• A department code registration dialog box appears.

3 Enter the department name in the “Department
Name” field, enter a 5-digit code in the
“Department Code” field, and click on
[SETUP].
• The new department code is registered.

ADVANCED button

Change button
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Editing a Department Code

1 Click on [ADVANCED] on the Department
Counter page.

2 Click the button in the “Change” column of the
department code which you want to edit.
• A department code modification dialog box appears.

3 Enter the department name in the “Department
Name” field, enter a 5-digit code in the
“Department Code” field, and click on
[SETUP].
• The department code is edited.

Change button

ADVANCED button
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Resetting a Department Counter

1 Click on [ADVANCED] on the Department
Counter page.

2 Click the button in the “Reset” column of the
department code which you want to reset the
counter.
• A confirmation dialog box appears.

3 Click on [OK].
• The counter of selected department code is cleared

and turn to “0”.

You can reset the counter for the department code.

SUPPLEMENT:

When you want to reset all counter, click on

[ALL] under the “Reset” column.

Reset button

ADVANCED button
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Deleting Department Counter Information

1 Click on [ADVANCED] on the Department
Counter page.

2 Click the button in the “Delete” column of the
department code you want to delete.
• A confirmation dialog box appears.

3 Click on [OK].
• The Selected department code is deleted and its

counter is cleared back to “0”.

You can delete an existing department code.  If you delete a department code, the counter information

for that department code is also cleared.

SUPPLEMENT:

When you want to delete all department

codes, click on [ALL] under the “Delete”

column.

Delete button

ADVANCED button
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Exporting Counter Information

1 Click on [EXPORT] at the bottom of the
Department Counter page.
• A New window is opened displaying the counter data

in XML form.

2 Click on the [File] menu of the browser and
select [Save As...].
• The Save As dialog box appears.

3 Select the location to which the counter data is
to be saved, enter the file name, and click on
[Save].
• The counter information is saved as an XML file.

You can export counter information as an XML format data.

EXPORT button
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Troubleshooting for the Installation
This section provides troubleshooting tips for the installation.

On a Windows computer

Setting up printing on Windows NT Workstations
If you have problems installing the GA-1140 with Windows NT, try installing another PostScript printer

(such as the Apple LaserWriter IIg), and then install the GA-1140.  Installing another printer insures that

all files are properly installed and available.

For instructions, see your Windows NT documentation.  For additional information about problems you

may encounter using the Adobe Printer Driver for Windows NT 4.0, see the Adobe README file

(ReadMeNT.txt) included in the prntdrvr folder on the User Software CD.

Reinstalling the Adobe PostScript Printer Driver on Windows 95/98/Me
If you are reinstalling the Adobe PostScript Printer Driver, delete any previous versions and related files

before installing. Search for and delete all files named Efme2020*.* in the Windows\System folder.

For additional information about problems you may encounter using the Adobe Printer Driver for

Windows 95/98/Me, see the Adobe README file (ReadMe9x.doc) included in the prntdrvr folder on the

User Software CD.
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On a Mac OS computer

Setting up the GA-1140 in the Chooser
If auto-setup does not work and you are prompted to select the PPD, select the appropriate GA-1140

file in your System folder:Extensions:Printer Descriptions folder.

Select “TOSHIBA e-STUDIO810srs-PS3UC” or “TOSHIBA e-STUDIO810srs-PS3EU”.

Installing screen fonts
If you experience problems installing the PostScript screen fonts from the User Software CD to the

System folder: Fonts folder, try the following:

1. Quit all applications and close all windows.

2. Create a new folder and name it “Uninstalled Fonts.”
• This folder must be located outside of the System folder.

3. Move fonts that you are not using from the System folder: Fonts folder to the Uninstalled Fonts

folder.

4. Install the fonts from the User Software CD to a folder called CD fonts. Copy the fonts to the System

folder: Fonts folder.

5. Create an alias to the System folder: Fonts folder and to the Uninstalled Fonts folder.

6. Place both aliases on your desktop.

7. When necessary, use the aliases to open both folders and move fonts between them.
• If you have any applications running, you must quit and relaunch them in order to view and use the newly installed fonts.
• Alternatively, you can try combining fonts from multiple suitcases into a single suitcase.
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Troubleshooting for Printing
This section provides troubleshooting tips for printing.

Maintaining optimal system performance

The GA-1140 does not require maintenance. Beyond the routine requirements of servicing and

maintaining the copier and replenishing consumables, there are a few things you can do to improve the

overall performance of your system:

Reduce unnecessary two-way communication.
If users notice that the server is frequently too busy to receive jobs, it may be because several users

are running utilities that are updated often. Large numbers of remote users running the Fiery WebTools

(optional) may have a significant effect on GA-1140 performance.

Schedule the printing workload by checking job ticket information before printing.
Print jobs with the same output and paper specifications together to minimize paper changes. Also,

print routine jobs while you prepare to print jobs with special instructions or special media.

Troubleshooting

In case of problems, and before you call for service, check the guidelines in this section.  If you are

unable to resolve the problem, make a note of the error condition and contact your authorized service/

support center.

This section provides some troubleshooting guidelines should a problem arise. If you are unable to

resolve a problem after referring to this section, contact your site operator or administrator.

General Printing Problems

You cannot connect to a GA-1140:
Make sure that the GA-1140 is not being calibrated from the Operation Panel.

If the GA-1140 is being calibrated from the Operation Panel, you can select it in the Chooser, but you cannot connect to it.
This insures that only one person is calibrating the server at any time and that print jobs do not use unexpected calibration.

You cannot select or view one of the queues:
Have your system administrator enable the queue in Setup.
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Printing seems to take too long:
Print to a queue instead of to the Direct connection.

When you print to a queue, the job is stored on the GA-1140 until it can be processed and printed; when you print to the
Direct connection, the job cannot be sent to the GA-1140 until the previous job is finished processing, so you must wait
longer to use your computer.

GA-1140 does not respond to a Print command:
1. Did you select the GA-1140 as the current printer?

Before printing, you must select the GA-1140 as the current printer from your computer.

2. Make sure that the copier is switched on.
Someone may have turned the copier off, or the Automatic Power-Off or Power Saver mode function may have engaged.
Even with the copier off, the GA-1140 appears in the Chooser.

3. If you are printing over an IPX (Novell) network, verify through the PCONSOLE utility that the job

was sent to the Novell queue and that the queue is being used by the GA-1140.

4. Make sure that the job does not contain a PostScript error.
Check with the operator, or use Fiery WebSpooler to check the job’s status. In Fiery WebSpooler, a job containing a
PostScript error appears in red.
To obtain information on the PostScript error, make sure the Print to PS Error option is set to Yes in GA-1140 Setup. See
the Administrator’s Guide for more information.

Jobs sent to the parallel port do not print:
1. Ask the administrator to increase the parallel “Port Timeout in Seconds” on the GA-1140 Operation

Panel.

2. Ask the administrator to change the Ignore EOF Character setting on the GA-1140 Operation Panel.
If you will be printing ASCII format PostScript only, set Ignore EOF Character to No; if you will be printing Binary format
PostScript, set it to Yes.

3. If you print using the DOS copy command, make sure to use the /b option when printing binary files.

4. Restart your Windows computer, enter BIOS setup, and if you have a BIOS setting for the parallel

port, make sure that it is set to Compatible mode and not to Bi-Directional, ECP, EPP, or any other

mode.

5. If you are using Windows 95/98/Me, open the System Properties Operation Panel, click the Device

Manager tab, click Ports, double-click the parallel port you are using, and make sure that the driver

selected is the standard Printer Port driver instead of the ECP Port, EPP Port, or any other driver.
For information about changing this setting, see your Windows documentation.



206

Problems with Print Quality

Print settings for the job do not match the settings you gave:
Make sure that you did not override the settings in another place because some settings are disabled

according to the priority of options.

You got poor printing results:
Does your application require one of GA-1140’s printer description files?

If you’re printing from Adobe PageMaker, make sure that the GA-1140 printer description file is installed correctly.
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Internal PCL Fonts List
The following 81 PCL fonts are resident on the GA-1140:

Courier

CG Times

CG Times Bold

CG Times Italic

CG Times Bold Italic

CG Omega

CG Omega Bold

CG Omega Italic

CG Omega Bold Italic

Coronet

Clarendon Condensed

Univers Medium

Univers Bold

Univers Medium Italic

Univers Bold Italic

Univers Medium Condensed

Univers Bold Condensed

Univers Medium Condensed Italic

Univers Bold Condensed Italic

Antique Olive

Antique Olive Bold

Antique Olive Italic

Garamond Antiqua

Garamond Halbfett

Garamond Kursiv

Garamond Kursiv Halbfett

Marigold

Albertus Medium

Albertus Extra Bold

Arial

Arial Bold

Arial Italic

Arial Bold Italic

Times New Roman

Times New Roman Bold

Times New Roman Italic

Times New Roman Bold Italic

Helvetica D12

Helvetica-ObliqueD12

Helvetica-Bold D12

Helvetica-Bold ObliqueD12

Helvetica-Narrow D12

Helvetica-Narrow-ObliqueD12

Helvetica-Narrow-BoldD12

Helvetica-Narrow-Bold-Oblique D12

Palatino-Bold D12

Palatino-BoldItalic D12

Palatino-Italic D12

Palatino-RomanD12

ITC AvantGarde-Gothic Book D12

ITC AvantGarde--Gothic BookOblique D12

ITC AvantGarde--Gothic Demi D12

ITC AvantGarde--Gothic DemiOblique D12

ITC Bookman-Demi D12

ITC Bookman-DemiItalicD12

ITC Bookman-Light D12

ITC Bookman-LightItalicD12

NewCenturySchlbk-Bold D12

NewCenturySchlbk-BoldItalicD12

NewCenturySchlbk-ItalicD12

NewCenturySchlbk-Roman D12

Times Roman D12

Times BoldD12

Times ItalicD12

Times Bold ItalicD12

ITC ZapfChancery-MediumItalicD12

Symbol

SymbolPSD12
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Wingdings

ITC ZapfDingbatsD12

Courier Bold

Courier Italic

Courier Bold Italic

Letter Gothic

Letter Gothic Bold

Letter Gothic Italic

Courier PSD12

Courier PS BoldD12

Courier PS Bold ObliqueD12

Courier PS ObliqueD12

Line Printer
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Internal PostScript Fonts List
 : The internal PostScript fonts are available only when the PS3 Upgrade (GE-1020) or PS3 Scan

& HDD Upgrade (GE-1060+GE-1110) is installed on the GA-1140.

The following tables list the 136 built-in PostScript printer fonts, 126 Adobe Type 1 fonts and 10

TrueType fonts, on the GA-1140.

Adobe Type 1 fonts
The GA-1140 includes 126 Adobe Type 1 fonts:

• The Mac OS column lists the name as it appears on the Font menu on a Mac OS computer. For

example, in most applications, to use “Bodoni-Bold,” choose Bodoni Bold from the Font menu.

• The Windows menu name is the name as it appears on the Font menu on a Windows computer. The

style refers to the style that must be selected in the application to access the particular PostScript

font. For example, to use “Bodoni-Bold,” choose Bodoni from the Font menu and Bold from the Style

menu.

PostScript name:

AlbertusMT-Light

AlbertusMT

AlbertusMT-Italic

AntiqueOlive-Roman

AntiqueOlive-Bold

AntiqueOlive-Italic

AntiqueOlive-Compact

Arial-BoldItalicMT

Arial-BoldMT

Arial-ItalicMT

ArialMT

AvantGarde-Book

AvantGarde-Demi

AvantGarde-BookOblique

AvantGarde-DemiOblique

Bodoni

Bodoni-Bold

Bodoni-Italic

Bodoni-BoldItalic

Bodoni-Poster

Mac OS menu name:

Albertus MT Lt

Albertus MT

Albertus MT It

Antique Olive Roman

Antique Olive Bold

Antique Olive Italic

Antique Olive Compact

Arial Bold Italic

Arial Bold

Arial Italic

Arial

Avant Garde

Avant Garde Demi

Avant Garde BookOblique

Avant Garde DemiOblique

Bodoni

Bodoni Bold

Bodoni Italic

Bodoni BoldItalic

Bodoni Poster

Windows menu name, style:

Albertus MT Lt

Albertus MT

Albertus MT, Italic

Antique Olive Roman

Antique Olive Roman, Bold

Antique Olive Roman, Italic

Antique Olive Compact

Arial, Bold Italic

Arial, Bold

Arial, Italic

Arial

AvantGarde

AvantGarde, Bold

AvantGarde, Italic

AvantGarde, Bold Italic

Bodoni

Bodoni, Bold

Bodoni, Italic

Bodoni, Bold Italic

Bodoni Poster
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Bodoni-PosterCompressed

Bookman-Light

Bookman-Demi

Bookman-LightItalic

Bookman-DemiItalic

Carta

Clarendon-Light

Clarendon

Clarendon-Bold

CooperBlack

CooperBlack-Italic

Copperplate-ThirtyThreeBC

Copperplate-ThirtyTwoBC

Coronet

Courier

Courier-Bold

Courier-Oblique

Courier-BoldOblique

Eurostile

Eurostile-Bold

Eurostile-ExtendedTwo

Eurostile-BoldExtendedTwo

GillSans

GillSans-Bold

GillSans-Italic

GillSans-BoldItalic

GillSans-Light

GillSans-LightItalic

GillSans-Condensed

GillSans-BoldCondensed

GillSans-ExtraBold

Goudy

Goudy-Bold

Goudy-Italic

Goudy-BoldItalic

Goudy-ExtraBold

Bodoni PosterCompressed

Bookman

Bookman Demi

Bookman LightItalic

Bookman DemiItalic

Carta

Clarendon Light

Clarendon

Clarendon Bold

Cooper Black

Cooper Black Italic

Copperplate33bc

Copperplate32bc

Coronet

Courier

Courier Bold

Courier Oblique

Courier BoldOblique

Eurostile

Eurostile Bold

Eurostile ExtendedTwo

Eurostile BoldExtendedTwo

GillSans

GillSans Bold

GillSans Italic

GillSans BoldItalic

GillSans Light

GillSans LightItalic

GillSans Condensed

GillSans BoldCondensed

GillSans ExtraBold

Goudy

Goudy Bold

Goudy Italic

Goudy BoldItalic

Goudy ExtraBold

Bodoni PosterCompressed

Bookman

Bookman, Bold

Bookman, Italic

Bookman, Bold Italic

Carta

Clarendon Light

Clarendon

Clarendon, Bold

Cooper Black

Cooper Black, Italic

Copperplate33bc

Copperplate32bc

Coronet

Courier

Courier, Bold

Courier, Italic

Courier, Bold Italic

Eurostile

Eurostile Bold

Eurostile ExtendedTwo

Eurostile ExtendedTwo, Bold

GillSans

GillSans, Bold

GillSans, Italic

GillSans, Bold Italic

GillSans Light

GillSans Light, Italic

GillSans Condensed

GillSans Condensed, Bold

GillSans ExtraBold

Goudy

Goudy, Bold

Goudy, Italic

Goudy, Bold Italic

Goudy ExtraBold
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Helvetica

Helvetica-Bold

Helvetica-Oblique

Helvetica-BoldOblique

Helvetica-Narrow

Helvetica-Narrow-Bold

Helvetica-Narrow-Oblique

Helvetica-Narrow-BoldOblique

Helvetica-Condensed

Helvetica-Condensed-Bold

Helvetica-Condensed-Oblique

Helvetica-Condensed-BoldObl

HoeflerText-Ornaments

JoannaMT

JoannaMT-Bold

JoannaMT-Italic

JoannaMT-BoldItalic

LetterGothic

LetterGothic-Bold

LetterGothic-Slanted

LetterGothic-BoldSlanted

LubalinGraph-Book

LubalinGraph-Demi

LubalinGraph-BookOblique

LubalinGraph-DemiOblique

Marigold

MonaLisa-Recut

NewCenturySchlbk-Roman

NewCenturySchlbk-Bold

NewCenturySchlbk-Italic

NewCenturySchlbk-BoldItalic

Optima

Optima-Bold

Optima-Italic

Optima-BoldItalic

Oxford

Helvetica

Helvetica Bold

Helvetica Oblique

Helvetica BoldOblique

Helvetica Narrow

Helvetica Narrow Bold

Helvetica Narrow Oblique

Helvetica Narrow BoldObl

Helvetica Condensed

Helvetica CondensedBold

Helvetica CondensedOblique

Helvetica CondensedBoldObl

Hoefler Text Ornaments

Joanna MT

Joanna MT Bd

Joanna MT It

Joanna MT Bd It

Letter Gothic

Letter Gothic Bold

Letter Gothic Slanted

Letter Gothic BoldSlanted

Lubalin Graph

Lubalin Graph Demi

Lubalin Graph BookOblique

Lubalin Graph DemiOblique

Marigold

Mona Lisa Recut

New Century Schlbk

New Century Schlbk Bold

New Century Schlbk Italic

New Century Schlbk BoldIt

Optima

Optima Bold

Optima Italic

Optima BoldItalic

Oxford

Helvetica

Helvetica, Bold

Helvetica, Italic

Helvetica, Bold Italic

Helvetica-Narrow

Helvetica-Narrow, Bold

Helvetica-Narrow, Italic

Helvetica-Narrow, Bold Italic

Helvetica Condensed

Helvetica Condensed, Bold

Helvetica Condensed, Italic

Helvetica Condensed, Bold Italic

Hoefler Text Ornaments

Joanna MT

Joanna MT, Bold

Joanna MT, Italic

Joanna MT, Bold Italic

Letter Gothic

Letter Gothic, Bold

Letter Gothic, Italic

Letter Gothic, Bold Italic

LubalinGraph

LubalinGraph, Bold

LubalinGraph, Italic

LubalinGraph, Bold Italic

Marigold

Mona Lisa Recut

NewCenturySchlbk

NewCenturySchlbk, Bold

NewCenturySchlbk, Italic

NewCenturySchlbk, Bold Italic

Optima

Optima, Bold

Optima, Italic

Optima, Bold Italic

Oxford
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Palatino-Roman

Palatino-Bold

Palatino-Italic

Palatino-BoldItalic

StempelGaramond-Roman

StempelGaramond-Bold

StempelGaramond-Italic

StempelGaramond-BoldItalic

Symbol

Tekton

Times-Roman

Times-Bold

Times-Italic

Times-BoldItalic

TimesNewRomanPS-BoldMT

TimesNewRomanPS-BoldItalicMT

TimesNewRomanPS-ItalicMT

TimesNewRomanPSMT

Univers-Extended

Univers-BoldExt

Univers-ExtendedObl

Univers-BoldExtObl

Univers-Light

Univers-Bold

Univers-LightOblique

Univers-BoldOblique

Univers

Univers-Oblique

Univers-CondensedBold

Univers-CondensedBoldOblique

Univers-Condensed

Univers-CondensedOblique

ZapfChancery-MediumItalic

ZapfDingbats

Palatino

Palatino Bold

Palatino Italic

Palatino BoldItalic

StempelGaramond Roman

StempelGaramond Bold

StempelGaramond Italic

StempelGaramond BoldItalic

Symbol

Tekton

Times

Times Bold

Times Italic

Times BoldItalic

Times New Roman Bold

Times New Roman Bold Italic

Times New Roman Italic

Times New Roman

Univers Extended

Univers BoldExt

Univers ExtendedObl

Univers BoldExtObl

Univers 45 Light

Univers 65 Bold

Univers 45 LightOblique

Univers 65 BoldOblique

Univers 55

Univers 55 Oblique

Univers 67 CondensedBold

Univers 67 CondensedBoldObl

Univers 57 Condensed

Univers 57 CondensedOblique

Zapf Chancery

Zapf Dingbats

Palatino

Palatino, Bold

Palatino, Italic

Palatino, Bold Italic

StempelGaramond Roman

StempelGaramond Roman, Bold

StempelGaramond Roman, Italic

StempelGaramond Roman, Bold Italic

Symbol

Tekton

Times

Times, Bold

Times, Italic

Times, Bold Italic

Times New Roman, Bold

Times New Roman, Bold Italic

Times New Roman, Italic

Times New Roman

Univers Extended

Univers Extended, Bold

Univers Extended, Italic

Univers Extended, Bold Italic

Univers 45 Light

Univers 45 Light, Bold

Univers 45 Light, Italic

Univers 45 Light, Bold Italic

Univers 55

Univers 55, Italic

Univers 47 CondensedLight, Bold

Univers 47 CondensedLight, Bold Italic

Univers 57 Condensed

Univers 57 Condensed, Italic

ZapfChancery

ZapfDingbats
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TrueType fonts
The GA-1140 includes 10 TrueType fronts:

PostScript name:

Apple-Chancery

Chicago

Geneva

HoeflerText-Black

HoeflerText-BlackItalic

HoeflerText-Italic

HoeflerText-Regular

Monaco

New York

Wingdings-Regular

Mac OS menu name:

Apple Chancery

Chicago

Geneva

Hoefler Text Black

Hoefler Text Black

Hoefler Text

Hoefler Text

Monaco

New York

Wingdings

Windows menu name, style:

Apple Chancery

Chicago

Geneva

Hoefler Text Black

Hoefler Text Black, Italic

Hoefler Text, Italic

Hoefler Text

Monaco

New York

Wingdings
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